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OverView

LazaLabl is a mini page-layout application which sets out and prints text and graphics within regular, 
equal, rectangular subdivisions of a larger page.

Examples are sheets of laser labels, and pre-perforated sheets of business cards, reply cards etc.    All of 
these come in sheets which contain some number of rows and columns of labels or cards.    The page 
doesn't actually have to be subdivided.    The limiting case is one row and one column, i.e. a whole sheet, 
or an envelope, etc.

You can work with LazaLabl at a number of different levels of complexity:

a) Copy an address from your favorite word processor, 
paste it into LazaLabl, then use LazaLabl to select a
suitable font and quickly print an address label.

b) Print several labels on a sheet, choosing where each
label should be placed.    If the label sheets are suitable
for feeding through the printer more than once, you will
be able to use up left over labels on partly used sheets.

c) Print a complete sheet of labels, choosing the individual 
label contents from a predefined Deck of labels
stored in a file.

d) Print a whole sheet of duplicate labels.

e) Print all the labels stored in a LazaLabl file, using as
many sheets as required.

f) Print multiple sheets of labels from an ASCII export file
produced by your favorite database program, adding
USPS bar codes if required.

g) Print labels with a fixed background such as a company
logo and return address, with addresses from your database
or from a LazaLabl deck file superimposed.

g) Make multi-layer compositions in which items of text
in a number of different typefaces and sizes, and graphics
are arranged exactly as you choose and superimposed
to make complex labels or cards.

h) Combine multiple multi-layer compositions on a single
sheet of cards or labels.

i) Produce complex labels with text, graphics, bar codes etc
using a maimerge technique.

Each label you print on a sheet can use a mixture of different typefaces or fonts using the standard 
Windows colors or LazaLabl's extended color palette.    You can use any of the TrueType or other 
scaleable fonts in your Windows installation.



You can also choose a display mode for individual cards/labels - more generally layers.    The display 
modes are:

Shrink2Fit
The text is centered on the layer.    If it is too big, the font size is adjusted so the text will just fit.

Maximize
The font size is increased to produce the largest text that will fit on the layer in its entirety, preserving 
the design aspect ratio of the font.

Scaled Text
The font size is adjusted in both height and width to fit a specified rectangular area.

WYSIWYG
LazaLabl prints the layer as you formatted it.

Serialize
The text on the layer is used to form the starting number for a sequence of serial numbers.

Postal    Bar Code
The zip code of an address is to be translated to a postal bar code.

Time/Date Stamp
The layer is always marked with the current time or date when it is printed.

Imported Picture
The text names a Windows 3.1 .BMP or .WMF file whose image is used on the layer.

Line
Rectangle
Ellipse
Polyline

The text and margin settings on the layer are to be used as the description of a geometric figure.

Barcode
The text of the layer specifies the data for a bar code (The bar-code module is an optional extra for 
LazaLabl).

Program
The layer is a set of instructions for composition of a compound object.

End of Group
The layer marks the end of a set of layers to be combined into a group.

Background
The layer is treated as a background element to be combined with any other background elements 
and a foreground layer.

Non-Printing Template
The layer is to be used as a background template for composition purposes only.    Its contents don't 
get printed

LazaLabl remembers the font and the display mode of    each layer when it stores a deck of layers in 
a file.



The contents of any number of layers, which may be in different or mixed typefaces, can be 
superimposed in one pass on the same card/label, along with graphic elements.

Card stocks and adhesive label sheets in numerous patterns,    are supplied by a number of 
manufacturers.    LazaLabl provides menu options for the most commonly used layouts from the 
major manufacturers.

The layout of the chosen stock is shown on the LazaLabl screen so that you can check the pattern 
against the stock you have on hand.

If the standard label and card sizes that LazaLabl provides are not enough, LazaLabl will allow 
you to specify user defined sheet layouts, and will remember them for future use.

LazaLabl can import graphics, either directly form .BMP (Windows bitmap) or .WMF (Placeable 
metafile) files, or through clipboard from other Windows applications.    It can print such graphic images at 
their designed size either at printer or screen resolution, or it can arbitrarily scale the image.





User Interface

User Interface Elements

The user interface of LazaLabl consists of six distinctive elements, along with the set of menus and 
dialog boxes that is customary in a Windows application.

Three of these elements are normally visible.    The other three can be brought into view as required and 
hidden when no longer needed.    The three permanently resident components are the Deck of cards or 
labels which is displayed at the upper left of the LazaLabl window, the Status Panel which is 
displayed at the lower left, and the layout - a representation of the target sheet of labels or cards - which 
appears at the right or upper right of the window.

The optional elements are the Preview, the Margins Tool, and the Color Palette.



The Label Deck

The labels or cards - layers - in the deck have written on them a text description of their contribution to a 
final printed label or card.    This may be shown in a particular color or typeface to show what you selected
for that component.    They are of a size which matches the size of the cards/labels on the chosen stock 
layout in Windows logical inches.    Logical inches are usually somewhat larger than an inch to 
compensate for the fact that we generally view screens from a greater distance than we read printed 
matter.

The label at the top of the deck is immediately accessible.    You can type something onto it, transfer that 
to any position on the layout, then print it.    There's no need to design a label before you can use it, and 
little restriction on how you use it.

Only the layer at the top of the deck has its face exposed.    To see the other layers you must shuffle 
through the deck, forwards or backwards, or jump to a particular layer number.    Cycling through the deck 
is done by clicking with the mouse in the area of screen above or below the deck and to the left of the 
layout.    A left click moves forward through the label numbers.    The effect is as if the top layer were 
removed and slid under the bottom of the deck.    A right click cycles backwards.    The effect is as if the 
bottom layer were pulled out from under the deck and placed on the top.    You can go to a particular layer 
number by selecting the GoTo option from the edit menu or clicking the  icon on the toolbar.

The number of cards in the deck is limited by available memory.    However in some cases the limiting 
factor will be the growth of the deck as labels or cards are added.    This growth is not one-for-one.    The 
deck has an illusion of depth, but the number of edges displayed is much fewer than the actual number of
cards in the deck.

To facilitate working with large cards or labels, options are provided so that the deck can be scaled down. 
Scaling is provided for the popular SVGA monitor resolutions (640x480, 800x600, 1024x748), and is such
that LazaLabl can handle a letter size (portrait) sheet when the deck is scaled down.    Of course 
scaling in this way makes it progressively more difficult to read small text.    The design of LazaLabl 
assumes that if you are working with letter size objects you will probably be making a small poster with 
larger text.    If you need to work with small text on a full sheet you may find it more convenient to do the 
work with a word processor.



The Layout

The Layout is a pictorial representation of the chosen label or card sheet - the current stock.

The layout can be changed at any time to reflect the choice of some other label stock by making choices 
through the Stock menu.    The layout allows you to determine where particular items are printed.    
Clicking on one of the white rectangular areas in the layout will transfer to it (position on it) a copy of the 
label at the top of the deck, along with any background labels which are present in the deck.    
Alternatively the layout can be filled automatically with successive items from the deck by choosing 
commands from the Control menu.

Once labels have been place onto the deck they can be printed by using one of the print commands from 
the File menu, or the toolbar - .    Only labels/cards which have been positioned on the layout can 
be printed.

The layout changes its size if the LazaLabl window is resized.    So if you maximize the window you 
will get a clearer view of the possibly minature label representations which have been placed on it.    
However, don't take these as gospel,    they are only intended as thumbnail sketches.    The Preview is the
WYSIWYG facility.



The Status Panel

The Status Panel is a button-like panel which displays:

the number of layers in the deck and the number of the layer currently exposed at the top of the deck

the type or nature of the layer currently exposed on top of the deck

the general font or typeface name for the layer at the top of the deck

the currently selected printer

The first line of information, the label count and current position in the deck is important in navigating 
about the deck.    It will also have consequences for the printed output, since if labels are being 
superimposed (superimpose) during the printing process or when they are being previewed (preview), the
order is significant.    Items printed first may be hidden or partly covered by items printed later (higher 
layer numbers).

Knowing the type or nature of the layers is important when the output isn't coming out as you want.    It is 
this sort of information you need to determine what you are doing wrong, or why things don't line up as 
you had hoped.

The font/typeface lets you to determine the name of the font that you used on a particular label or card, 
so, for example, you can repeat the style on another.

The printer information reminds you which printer you are currently connected to (printer setup) so that 
you can ensure that it is on-line and connected, and loaded with the required label or card stock.



The Margins Tool

The layers in the Deck can have margins set on all four sides - left, top, right, and bottom.    Margin 
adjustments are made using the Margins Tool.    This is a small dialog box with four scroll bars, one for 
each margin, and a close button.    It is opened by selecting the Margins Tool option from the Control 
menu, or the  icon from the toolbar.    Once it is open it can be left open and visible on-screen for as 
long as it is required.

Adjustments to the scroll bars set the margins of the layer at the top of the deck, though you'll only see 
movement if you have the Preview turned on.    Moving the left and top margins generally move the 
contents of the label left and down.    Movements of the right and bottom margins can constrain the 
contents within a smaller area or cut them off, depending on the type or nature of the label.

The scroll bars are accompanied by numeric indicators which show the current position of each margin in 
thousandths of an inch.    These indicators can be used when it is required that different layers in the deck
have equal or relative margin values set.



The Preview

LazaLabl allows simple labels which can be printed with confidence as soon as they have been 
typed into the layer at the top of the deck.    It can also produce very complex compositions on labels, 
business cards, reply cards etc.    In complex cases it is usually necessary to have a what-you-see-is-
what-you-get view of the composition in order to get it correctly laid out.    This is the purpose of the 
Preview.

The Preview is turned on by selecting it from the Control menu, or by clicking the  icon on the toolbar.   
Once it is turned on it remains on while most other operations are executed.    Some operations which 
might make the preview inaccurate, or volatile, automatically turn it off.

You can turn it off yourself by clicking on it with the right mouse button, or by selecting the preview option 
while the preview is already on.

In particular it remains displayed while cycling through the deck (flip to next, flip to previous), adjusting 
fonts (font) colors (color) and margins, and adjusting scale (adjustments).    File operations, label stock 
changes, and adjustments to the layout (position) turn it off.

The preview panel also shows a thin dotted line "elastic rectangle" which you can grab with the mouse 
pointer to size or move objects in the preview.    To get a clear view of the Preview without this, hold down 
the Ctrl key and left-click on the preview area.



The Color Palette
Many color monitors/display adaptors in use with Windows will support at least 256 colors.    However 
Windows itself only supports a palette of 20 colors.    With the increase in popularity of relatively cheap 
color printers this is becoming an unreasonable limitation.    LazaLabl has its own palette of 125 
colors which can be brought into play on monitors that arecapable of displaying at least 145 colors.    This 
is turned on by the Color Palette option of the Options menu, or by the rainbow icon  on the toolbar.    
When the host system doesn't support enough colors, this menu item is disabled.    To conserve memory 
for users who don't use color, the palette is only created when it is specifically requested or when the user
loads a LazaLabl file (a .LZG file) which specifies palette colors.

Like the Preview and the Margins Tool, the palette can be left visible and active for as long as it is 
required.    It has a close button to turn it off when it is no longer needed. 

The Color Palette is used by clicking on the color required.    A panel at the bottom of the palette shows 
the selected color, and the selected color box is also outlined.    Selecting a color effects the layer at the 
top of the Deck in one of two ways.    If a portion of the text has been highlighted, the highlighted text is 
set to the requested color.    If there is no highlighted text, all the text in the layer is set to the requested 
color except for any sections that were previously highlighted and colored.    The text of a label can thus 
be regarded as falling into two categories.    Default text, which can be colored as a whole, and text which 
is differentiated from the rest by a separate color (actually by a separate color or a separate font or both).  
You can change the general color of a label's text as often as you like, but there is a limit of 15 other 
highlight colors per label.

The default color, that is the color of text that you have not explicitly set to some other color, is black.

If LazaLabl's palette has not been activated, it is also possible to select colors from the font choice 
dialog    box.    In that case your choice is limited to the 20 standard Windows colors.    This facility will be 
quite adequate when only simple colors are required, and it provides consistency with many other 
applications.





File Menu
The following is a summary of the file menu options:

New 
Clears the deck, prompts to save changes.

Open 
Opens a LazaLabl deck file.

Save 
Saves current changes to a deck file.

Save As 
Make a new file from the current deck.

Export the Preview 
Make an exported graphics file from whatever you see in the Preview.

Add Deck to Existing File 
Tag the deck contents onto the end of an existing deck file.

Add Deck File to Deck 
Add the contents of an existing file to the current deck

Delete Current File
Clears the deck and deletes the deck file from disk.

Print Immediate 
Quick print.

Print via Dialog 
Customize printer for one print job.

Print LazaLabl Deck File 
Automatically print a LazaLabl deck file.

Merge/Print ASCII Import 
Do a merge from an ASCII delimited source - print each sheet as is is loaded.

Merge/Load ASCII Import 
Do a merge from an ASCII delimited source - keep the data in the deck.

Other ASCII Imports
Print or load other ASCII sources as-is (no merging).

Print Paragraph Text
Load Paregraph Text
Print ASCII Delimited Report
Load ASCII Delimited Report

Printer Settings
Printer Setup - Customize printer for the LazaLabl session
Margin Trims - Set permanant printer margin adjustments



Printer Margin Test - Print out a printer margin test
Auto Margin Compensation - Switch margin compensation ON/OFF

Exit 
Quit LazaLabl, prompts to save any changes



New
Use this option to clear the existing deck of labels prior to creating a new set of labels.

If the existing deck of labels has been modified and and has not been saved you will be prompted to save
it.The result of the New operation is that the deck is reduced to a single empty layer.



Open

The Open option loads a deck of labels from a LazaLabl file.

If you have made changes to the existing deck, you will be prompted to save them.

A standard Windows Open-File dialog box pops up.    The directory will be set to the one you specified 
when LazaLabl was installed. 

The Open-File dialog allows you to change drive and directory if you need to.    When you have the 
required directory,    pick a deck file from the file listbox by double clicking on its name, or highlight it and 
click OK.

LazaLabl files have a name similar to:

name.lzg

The file extension "lzg" is short for LazaLabl Group.

The contents of the file will be loaded into the deck.    If the stock displayed on screen does not match that
which was on screen when the group file was created, LazaLabl will remind you, and ask if you want 
to change back to the original label layout.    You don't have to change back if you don't want to.    
However you should be sure that if you don't, the contents of the deck will fit onto the layout that is 
currently selected.

Once the labels are loaded into the deck you can modify them or print some or all of them as you please.



Save
The Save option saves the contents of the deck if the deck has been modified.    This happens silently 
and immediately if the deck was originally loaded from a file, so that LazaLabl knows where the 
modified deck is to be stored.    (If LazaLabl knows the name of the current file, then the name is 
displayed in the caption bar at the top of the LazaLabl window.) 

If    LazaLabl doesn't have a file name, the caption bar will read "LazaLabl - (Untitled)",    and the 
Save option will have the same effect as the Save As option.

In the latter case a standard Windows Save-As dialog box pops up.    The dialog box allows you to choose
a drive and directory where the file is to be stored, and to specify a name for the file.

The default file name extension is shown in the file name edit box, where you will find the string:

*.lzg

The extension "lzg", is short for LazaLabl Group.    This is the standard extension for LazaLabl 
files, and it will be added automatically if you simply type in a file name.    For example, if you type "fred", 
the "*.lzg" text will disappear, but the saved file will be called "fred.lzg".

If you choose a name which is already in use, Windows will tell you that the file already exists and will ask
if you want to replace the existing file.    If you don't, respond NO, then type in another name.

When you press the Save-As dialog OK button, the labels will be stored in the chosen file, along with a 
note of the currently selected stock layout, palette etc.



Save As
Use the Save As command to save a deck you have loaded from an existing file under a new name.

When you choose the Save As option, a standard Windows Save-As dialog box pops up.    This allows 
you to choose a drive and directory where the file is to be stored, and to specify a name for the file.

The default file name extension is shown in the file name edit box, where you will find the string:

*.lzg

The extension "lzg", is short for LazaLabl Group.    This is the standard extension for LazaLabl 
files, and it will be added automatically if you simply type in a file name.    For example, if you type "fred", 
the "*.lzg" text will disappear, but the saved file will be called "fred.lzg".

If you choose a name which is already in use, Windows will tell you that the file already exists and will ask
if you want to replace the existing file.    If you don't, respond NO, then type in another name.

When you press the Save-As dialog OK button, the labels will be stored in the chosen file, along with a 
note of the currently selected stock layout.



Export the Preview

If you have gone to the trouble to create some composition using LazaLabl then it's possible that you
might want to insert it into a word processor document,    or use it to make a slide or more generally to 
export it into some other application.    If you've made a business card you might want to use it on your 
internet web page.

When you have finished a composition and you are happy with the preview you can export it in one of 
several graphics formats.    The nature of the composition doesn't matter.    It could be a single label, a set 
of background labels combined with a foreground label,    a superimposed set, or a group.    The set can 
include layers which are themselves imported pictures, and if you have scaled them, the scaling will be 
preserved.    If you want a frame round the composition you can easily add one.    Just add a background 
or superimposed layer with zero margins, type in a number for the line thickness, and select the 
Rectangle option from the Options menu.

When you are ready, select    Export the Preview from the File menu.    A file-save dialog box will pop up 
to allow you to choose a name and file type for the exported file.    Choose a file type,    your options are:

.GIF - Compuserve GIF format

.JPG - JPEG (Joint Photograpic Experts Group) format

.PNG - Portable Network Graphics format

.WMF - Windows Metafile format.

Please note that we don't guarantee to support the GIF format in future.    The compression method used 
in GIF files is subject to a patent,    and GIF files should generally be phased out.

Then type in a file name, and click OK.    LazaLabl will generate the required graphic file.    In the 
case of .JPG and .PNG files you have a choice of generating interleaved or progressive versions. 

Note that compression of graphic images is a complex operation.    LazaLabl's caption bar will ask 
you to wait - Please be patient!

PNG will be the ideal format for the sort of images that LazaLabl generates.    It is supported by 
several major web browsers, and the others can be expected to come into line.

If you're exporting the image for use in another Windows application, such as a word processor,    
the .WMF format will probably be the best choice.    WMF is a vector format which scales better than the 
others, which are bitmap formats.

To use the metafile you might typically insert it into your word processor document.    Use the insert-
picture option, select .WMF as the picture file type, and select the file you made with LazaLabl.    The 
"label" should appear in the word processor much as you saw it in LazaLabl, and should print looking
just the same.



Add Deck to LazaLabl File

LazaLabl tries to make it as easy as possible to copy an address etc. from some document you are 
working on, and to print that information on a label.    Quite often though you will want to take a step 
further and add the address to a list of frequently used addresses or some similar file.    The Add Deck to 
Existing File option attempts to make this as easy as possible.

The typical situation will be when you have a single address on a single label in the deck.    You decide 
you want to save that in an already existing LazaLabl deck file.    One option would be to copy the 
label to the clipboard (Copy Label from the Edit menu), open the file, start a new label, paste the 
contents of the clipboard onto it, then save the file.

The Add Deck to Existing File option offers a simpler alternative.    The label you want to add to the file 
is in a single label on the deck.    Select Add Deck to Existing File from the File menu.    A file-open 
dialog box pops up to allow you to choose the file.    Once you have chosen it, you are through.    The 
contents of the deck will have been tagged onto the end of the existing file.    This works whether there is 
a single label in the deck or a whole heap of labels.



Add LazaLabl File to Deck

This option is intended to be used to combine group files into a temporary deck of labels so that they can 
be printed onto a sheet or sheets of labels together, or so that you can choose a selection from both onto 
a sheet and print them.    It is also useful if you have a stored merge specification and you want to place it 
on top of some background layers.

Choose Add LazaLabl File to Deck from the File menu.    The contents of the file are added to the 
current deck, but the file itself is not opened.    The file name in the LazaLabl title bar is not changed.  
Nothing you do to the deck will effect that file.    You have simply copied its contents.    The effect on the 
deck is just as if you had typed the labels in.    If you use this option to combine a number of group files 
into the deck, you can make a new composite file using the Save As option from the File menu,    using a 
new file name.



Delete Current File
This option allows you to clear the deck and delete the associated .LZG file from disk storage.    Use it 
with caution - LazaLabl does not have provision for restoring such deleted files.

A message box will pop up to allow you to confirm your delete request.    Experienced users who prefer 
not to be prompted can suppress this by adding a line to the [defaults] section of the initialization file 
LAZLAB.INI (LazaLabl install puts this in the WINDOWS directory), as follows:

delwarn=0



Print Immediate
Shortcut Key Ctrl+P

Choosing the Print Immediate option of the File menu, or using the correponding toolbar icon causes the
contents of the layout to be sent directly to the default printer.

The items that were placed on the Layout are printed in the corresponding positions on the actual sheet of
cards, labels, or paper.

The printing takes place at once, without any request for confirmation, so you should be sure that the 
default printer settings are appropriate.

The images that were displayed on the Layout will be cleared as the printing progresses, so that more 
can be positioned if required.



Print Via Dialog

LazaLabl provides a Print via Dialog dialog box option in the File menu, and a corresponding 
toolbar icon that allow you to make adjustments to the printer setup etc, that effect only a single print job.   
Common examples of such a requirement are when you need to print multiple copies of the same sheet, 
or print a single sheet in landscape mode.

When printing is initiated through the Print via Dialog option or the corresponding toolbar icon, a printer 
setup dialog box pops up.    This can be used to make any required changes.    Remember that changes 
made in this way have effect only for the output of that particular print command.

If printer setup changes are required to last for the duration of the LazaLabl session, they must be 
made using the Printer Setup sub-option of the Printer Settings option of the File menu.    Changes 
made in this way do not effect the Windows default settings.    However they will persist for LazaLabl 
initiated print jobs until you exit from the LazaLabl session.To effect the Windows default settings you
must use the Control Panel, Printer Settings, or Print Manager.

Printing Multiple Copies

Most laser printers can print multiple copies of the same sheet of output.    However some other printing 
technologies do not offer this capability.    Whether the printer can do it or not, the Print via Dialog dialog 
box offers you the possibility of printing multiple copies.    If the printer can't do it, LazaLabl can 
explicitly print multiple copies for you.    Be aware that this process can be slow in the case of complex 
documents, so, when the printer can't handle them itself, LazaLabl will request that you confirm the 
multiple copies.
 
There is one case when the printer derfinitely can't be used to make multiple copies.    LazaLabl 
allows you to print serialized labels etc, on which the serial number is automatically incremented for each 
label printed.    In this case LazaLabl looks after the printing of multiple copies itself.    Even though 
the printer could make duplicates, in this case exact duplicates are not what is required



Print Deck File

The Print Deck File option prints the contents of a LazaLabl deck file, without requiring much further 
intervention from the user.

An Open-File dialog box pops up to allow you to choose the deck (.LZG) file.

If the stock displayed on screen does not match that which was on screen when the deck file was 
created, LazaLabl will remind you, and ask if you want to change back to the original layout.    It is not
necessary to change back, but you should be sure that the contents of the deck will fit on the selected 
layout if you don't.

The first sheet of labels are read from the file.    The user is then prompted to check that the printer is on-
line and loaded with appropriate sheets, with the option of cancelling the operation.    If the operation is 
confirmed, a "click to stop printing" button appears to allow the process to    be aborted.    Otherwise all the
labels in the deck are paced on successive sheets and printed automatically.

LazaLabl always uses the labels at the bottom of a sheet first.    This gives the best probability of a 
successful re-feeding of the partly used sheet.    So if the batch, as is very likely, does not correspond 
exactly to a multiple of the number of labels on the sheet,    the labels at the bottom of the last (partly 
used) sheet will be used first.



Merge/Print Delimited Text
Virtually all database systems, spreadsheets and word processors can export data lists in delimited text 
format.    This format is probably the most general data interchange format available.

The delimited text format represents data values (fields or columns of a row or record in database terms, 
or cells of a row in a spreadsheet) as text.    Each value is separated from its predecessor and successor 
in the row or record by a comma.    Records or rows are separated by an end of line.

This format presents no difficulties for blank fields, simple words or names, numbers, dates, etc.    There 
is no conflict with the separating commas, for example:

,FRED,1.234,12,9/12/93,,22

Here we have a blank field (nothing before the first comma), a name - FRED, two numbers - 1.234 and 
12, a date - 9/12/93, another blank field (nothing between the commas), and another number - 22.

A problem arises when the data contains text, since the text may contain commas.    The convention to 
get around this is to put data items that are regular text in quotation marks.    A typical example of text that 
would be a problem is:

Hackettstown, NJ 07840

The conventional comma delimited format would tag this onto our existing record enclosed in double 
quotes, as in:

,FRED,1.234,12,9/12/93,,22,"Hackettstown, NJ 07840"

The whole scheme is completed by imposing the extra condition that if a text data value contains    
quotation marks, these must be doubled up so that they can be distinguished from those used as 
delimiters.    So if we have another text field

"By Jove" he cried

We would end up with the record:

,FRED,1.234,12,9/12/93,,22,"Hackettstown, NJ 07840",
"""By Jove"" he cried"

(The line is split here to get the characters on the page, the split is not part of the record.    It couldn't be, 
because a new line means end of record.)    This use of doubled-up quotation marks doesn't crop up 
much in practice.

The paragraphs above describe the sort of text output you will normally get if you tell your database, 
spreadsheet, etc, to export a table or file as delimited text, and this is what LazaLabl can import.

In most cases when you are importing records of this sort, you will not be interested in the values of all of 
the fields.    For example if you are printing address labels from a customer database, you may not need 
to include the customer's account number, and you almost certainly won't want to include the oustanding 
balance.    To pick out the fields of interest, LazaLabl simply requires that you specify field numbers.    
The first field in the record is number 1, the second number 2 and so on,    reading from left to right.



LazaLabl requires these field numbers to be presented in the form of a simple merge specification.    
Let's assume that the database contains records consisting of:

Field Name Field Number

CUSTOMER    # 1
TITLE 2
FIRST NAME 3
MIDDLE INITIAL 4
LAST NAME 5
STYLE 6
COMPANY 7
ADDRESS1 8
ADDRESS2 9
CITY 10
STATE 11
ZIP 12
LAST TRANSACTION DATE 13
BALANCE 14

To print simple addresses we will need a merge specification that looks something like this:

[?2] [?3] [?4]. [5] [6]
of company [7]
[8]
[9]
[10], [11] [12]

The square braces are there to distinguish the field numbers from other text in the specification.    We've 
included a rather silly example of such text on the second line.    The phrase "of company " is just some 
text that LazaLabl is to add between whatever field values it finds for fields 6 and 7 (as well as the 
line break).    You can have any text you like between the field numbers as long as it doesn't contain 
square braces (if square braces are essential, you can force them by prefixing them with a backslash 
character - '\'.    Because of this use of the '\' character, if you want an actual '\' character in the merge 
specification, use two of them "\\").    The spaces between other fields, and the comma and space 
between CITY and ZIP (fields 10 and 11) are other examples of text between the field numbers.

The square braces and the numbers don't get printed.    LazaLabl substitutes for them the value of 
the corresponding fields in the database record that it is importing.

The first three field numbers have question marks within the square braces, before the number.    This 
means "if this field is blank, don't bother to print the text from here up to the next field number".    With 
these fields in particular it means don't print the spaces, or in the case of the middle initial field, don't print 
the period and space.

If you want to make multiple copies of a merged item, use can use a multiple copy dot command at the 
start of the first line of the template:

.m 5 // always make 5 copies

.m [15] // use the number in field 15 to determine number of copies

Any text in the first line following the multiple copies command is ignored.    The .r command is ignored in 
WYSIWYG and Macro layers.    It doesn't work in a regular shrink2fit layer (it will simply be treated as part 
of the text).



What if the ADDRESS2 field ([9])is blank?    This happens quite often in real data.    Does it mean that we 
will get an address printed that has an empty line where the second line of the address should be?      It 
doesn't.    LazaLabl will remove such blank line unless you tell it otherwise (see the Strip Empty 
Lines from Input option of the Adjustments menu).

The merge specification goes on the layer at the top of the deck,    the last layer in the sequence - one of
one or two of two or whatever.    For that top layer you set the font, color, and margins you want to be 
applied to all of the records from the database.    If you want postal bar codes to be printed on the labels 
from the ZIP codes in the database, then that option (Postal Bar Codes from the Options menu) should 
be selected for the layer at the top of the deck. There can be other layers underneath that are in 
background mode.    These can apply a return address, a company logo, or both, to the labels printed 
from the database.    Any number of underlying background labels will be printed on each label, along with
the information from each record of the database and the text in the merge specification.

To initiate a merge/print, select Merge/Print ASCII Delimited Text from the File menu.    A file-open dialog
box will pop up to allow you to choose the file containing the data exported from the database.    When 
you have chosen the file, the first page full of records will be loaded into layers on the deck, displacing the
merge specification, and on top of any background labels that were underneath it.    The sequence of 
labels will be placed on the Layout.

LazaLabl then asks you to confirm that the printer is ready and loaded with suitable stock.    At this 
point you can cancel if you wish.    If you choose to go on,    LazaLabl will load and print a page of 
records at a time until the input data is exhausted.    A button will appear in the LazaLabl window 
which you can click to terminate the print job.    The button text notes the number of pages printed.    When
printing is completed the deck reverts to its original state.

If something goes wrong, and only part of the batch gets printed, use an editor like Windows Notepad or 
Windows Write, or your favorite text editor to change the database exported file.    Simply delete the lines 
that have already been printed, and run the merge again for the remainder.    If you want to keep all of the 
data, make a copy of the whole data file first!



Merge/Keep Delimited Text

If you intend to make any additions, changes or deletions within LazaLabl to the data that you are 
importing from an ASCII delimited file, provide a merge specification as detailed in Merge/Print Delimited
Textt, then choose Merge/Load Delimited Text from the File menu.    

This option will bring the desired data in, placing it the deck, but unlike the Merge/Print Delimited Text 
option, it does not import it a page at a time and print it immediately.    All of the database records are 
placed in the deck.    At this time you can flick through the deck, as you would with any other group of 
labels, making any additions, changes, corrections, or deletions that you want to the imported data before
printing or saving.    Use the Save As option of the File menu if you want to retain the modified import for 
future use.

Remember that all of the data you import will be stored in the deck.    This means that it will be stored in 
memory, so the number of records you can deal with in this way has a limit, though it's quite generous.



Print Paragraph Text
Addresses etc are often kept in a simple paragraph format by word processors etc.    A typical example 
would be:

Steve Teale
30 Petersburg Road
Hackettstown,    NJ 07840

John Doe
123 Washington Avenue
Anytown,    US 00000

The addresses (more generally - items) are separated by a single empty line.

LazaLabl can print labels from an ASCII text file of this sort, one paragraph to a label.

To initiate a paragraph print, select Print Paragraph Text from the Other Text Imports section of the File
menu.    A file-open dialog box will pop up to allow you to choose the file containing the text data.    When 
you have chosen the file, the first page full of labels will be loaded onto the layout,    on top of any 
background labels that are defined.

LazaLabl will then asks you to confirm that the printer is ready and loaded with suitable labels or 
paper.    At that point you can cancel if you wish.    If you choose to go on,    LazaLabl will load and 
print a page of labels at a time until the input data is exhausted.    A button will appear in the LazaLabl
window which you can click to terminate the print job.    The button text notes the number of pages 
printed.

If something goes wrong, and only part of the batch gets printed, use an editor like Windows Notepad or 
Windows Write, or your favorite text editor to change the text file.    Simply delete the paragraphs that 
have already been printed, including the empty line that follows the last of them, and run the print job 
again for the remainder.    If you want to keep all of the data, make a copy of the whole data file first!



Load Paragraph Text

If you intend to make any additions, changes or deletions within LazaLabl to the data that you are 
importing from a paragraph text file,    use the Load Paragraph Text option of the Other Text Imports 
section of the File menu.

This option will bring the desired data in, placing it the deck, but unlike the Print Paragraph Text option, 
will not import the data a page at a time and print it immediately.    All of the imported paragraphs will be 
placed in the deck.    At this time you can flick through the deck, as you would with any other group of 
labels, making any additions, changes, corrections, or deletions that you want to the imported data before
printing or saving.    Use the Save As option of the File menu if you want to retain the modified import for 
future use.

Remember that all of the data you import will be stored in the deck.    This means that it will be stored in 
memory, so the number of records you can deal with in this way has a limit, though it's quite generous.



Print Delimited Text Report
This option allows you to print labels from delimited text reports generated by other applications, typically 
database programs.

A delimited text file, in the restricted sense in which we will discuss them here, represents an address 
such as:

SoftCentre Inc
30 Petersburg Road
Hackettstown,    NJ 07840

as a single line of text in the form:

"SoftCentre Inc","30 Petersburg Road","Hackettstown,    NJ 07840"

Each line of the address appears in quotes, and the lines are separated by commas.    The end of the line 
signals the last line in the address.

Most database programs allow the definition of reports that will produce files in this sort of format.    Files 
of this general form are usually described as delimited text files files.    The delimiter here is the comma, 
and the quotes are used so that individual items (lines) can have commas in their text without introducing 
ambiguity.    If quotes are not used, then the character used as delimiter can't appear in the items.    This 
may be acceptable if the delimiter is some relatively obscure character like the backslash or the vertical 
bar, and it may also be acceptable if the delimiter is the tab character

LazaLabl will print labels from such files using its default font, and the Shrink2fit mode.

Selecting the Print Delimited Text Report option causes an Open-File dialog box to pop up.    Two file 
name filters are offered.    The first, and the one you will see immediately in the Open File dialog box, 
shows all the files in the chosen directory that have the extension ".txt".    If your database can name files 
with this extension, you can simply double click on the required file.    Otherwise you will need to select the
"*.*" filter from the listbox at the bottom left of the Open File dialog box.    The file name listbox will then 
show all the files in the chosen directory, so that you can pick the one you need.

When you have chosen a file,    LazaLabl will ask you to confirm that the appropriate label sheets are 
loaded and that the printer is ready.    The batch of labels will then be printed automatically.    A "click to 
stop printing" button is displayed so that you can abort the process.    If LazaLabl can not make sense
of the file contents it will display a warning message box and then abandon the attempt.

Unless you take a lot of trouble designing the report, database report generators often generate delimited 
text output files with blank fields, for example:

"John Doe","","PO Box 1","Anytown, NJ 07000"

If LazaLabl comes across a record like this it will normally print it as:

John Doe
PO Box 1
Anytown, NJ 07000

not as:

John Doe



PO Box 1
Anytown, NJ 07000

That is, if LazaLabl finds that a particular line is empty, it will simply ignore it.    Looking at it another 
way it will strip out blank lines.    This behavior is controlled by the Strip Empty Lines from Imports 
option of the Adjustments menu.    Normally stripping is turned on.    If you want the blank lines left in, 
turn it off.

Delimited Text Files - Choice of Format

The format accepted by LazaLabl is controlled by entries in its initialization file - LAZLAB.INI, which 
the install program will have copied into your Windows directory.    If you want to use quote and delimiter 
characters other than the double quote mark and the comma, that LazaLabl uses by default, you can
specify character values (decimal character numbers) for the opening quote, closing quote, and delimiter. 
Details are given in Appendix E of the manual.



Load Delimited Text Report
If you want to make any changes or deletions to the data that you are importing via a database report, 
choose Load Delimited Text Report from the File menu. 

This option will bring the entire file data in, placing it in the deck, but unlike the Print Delimited Text 
Report option, the Load option does not load records a page at a time and print them immediately.    All 
the records are transferred to the deck.    At this time you can flick through the deck, as you would with 
any other group of labels, making any additions, changes, corrections, or deletions that you want to the 
imported data before printing or saving.    Use the Save As option of the File menu if you want to retain 
the modified import for future use.

Remember that all of the data you import will be stored in the deck.    This applies that it will be stored in 
memory, so the number of records you can deal with in this way will be limited, though it's quite generous.



Printer Settings

Printer Setup - Customize printer for the LazaLabl session
Margin Trims - Set permanant printer margin adjustments
Printer Margin Test - Print out a printer margin test



Printer Setup

If printer setup changes are required to last for the duration of your LazaLabl session, they must be 
made using the Printer Setup option of the Printer Settings sub-menu.    Changes made in this way do 
not effect the Windows default settings.    To effect the Windows default settings you must use the Control 
Panel, Printer Settings, or the Print Manager.



Margin Trims

Windows allows an application to determine the size of the printing area for a supported printer via the 
printer driver.    This is usually smaller than the paper the printer is set up to use.    It is also possible for an
application to determine where this printing area is.    It may be centered in the page, or may be towards 
the top or bottom, or one of the sides.    With most document processing this is not critical.    However, with
labels or forms it is crucial, since text must be placed accurately with respect to the edges of the labels.

LazaLabl uses this capability to determine what margins it needs to apply when labels etc are 
printed.

However, not all printer drivers report the print area dimensions relative to the nominal sheet size 
correctly.    Similarly, not all printers are correctly aligned.    Both of these factors can lead to a consistent 
bias in the way that labels are positioned on sheets.

To allow for errors in drivers and printer mechanisms, LazaLabl offers you the ability to set printer 
Margin Trims to compensate for any such consistent bias.    You should apply such settings if your labels 
etc always seem to get printed too far up the page or too far down or too far to the left or right.

Selecting Margin Trims from the Printer Settings sub-menu causes a Printer Margin Trims dialog box to 
pop up.

Enter a top and, or, left trim value in thousandths of an inch, with or without a minus sign.    Negative 
values move the images up the sheet, or, in the case of the left trim, to the left.    Positive values move the
images down the sheet, or, in the case of the left trim, to the right.    For example    if the print on your 
labels is about a tenth of an inch too high up, enter 100 (thats 0.1") to increase the top margin and move it
down.    If the print is a tenth of an inch too low enter -100 to move it up.    Adjust the left margin similarly if 
required, though this is less often a problem.

Once the Margin Trims have been set, LazaLabl will remember the settings for that printer by name. 
Those trims will be applied only to printers of that type.    However note that if the trims are being used to 
compensate for printer misalignment it will probably be neccessary to change the trim values if another 
printer of the same type is connected.



Printer Margin Test
The Printer Margin Test option should help SoftCentre to give better support if print alignment problems 
are experienced.    Selecting this option allows you to print a rectangle that shows the useable area of 
your printer.    If you need help with margin trim setting it would be helpful if you could print this test and 
have a ruler handy before you phone for tech support.



Auto Margin Compensation
Many label manufacturers make label sheets with margins narrower than the hardware margin widths of 
many printers.    Such printer margins make it impossible to use the full area of the outside labels.    (the 
left and right    and top and bottom rows of labels).    Under these circumstances, LazaLabl can print 
in two modes:

a) When Auto Margin Compensation is ON (the default), it adjusts the size of the outside labels to take 
account of the printer margins.    The contents of the label are then scaled into the reduced area.    In this 
mode,    the contents are preserved, but the scaling may distort the layout.

b) When compensation is OFF, the label contents are printed where they are supposed to be.    Parts of 
the design may fall within the printer margins, and they will not be printed.

This is of course a choice between a rock, and a hard place, but until printer manufacturers agree to 
produce printers with universally recognized maximum margin widths, and label manufacturers make 
sheets of labels which always have margins at least that wide,    you will have to choose between scaling 
and clipping.

If the printer driver doesn't report the margins and/or printing area size accurately,    you may get clipping 
in either case.



Exit

Selecting Exit from the File menu will end your LazaLabl session.    If you have modified the labels in
the deck LazaLabl will ask if you want to save the changes.    You will be asked the same question if 
you use the Close option from the system menu or press Alt+F4.





Edit Menu
The following is a summary of the Edit menu options:

Undo
Undo the last edit operation on the label/card at the top of the deck if this is posssible

Cut
Remove the highlighted portion of text and transfer it to the clipboard

Paste
Insert the contents of the clipboard at the current caret position

Copy
Copy the highlighted portion of text to the clipboardcopy

Copy Label
Copy the text of the label at the top of the deck to the clipboard

Clear
Clear the text of the label at the top of the deck

Go To Label #
Go to a specified label number in the deck

Search
Search for a string of characters in the deck

Replace
Search for and replace a string of characters in the deck

Frequently used Phrases
Set up frequently used text fragments which can be inserted by a keystroke



Undo, Cut, Paste and Copy
These editing commands work in the same way as for most Windows text processing packages, for 
example the Windows Write Program.    Consult your Microsoft Windows documentation or the Help 
system for a standard Windows package like Write if you are not clear on how to use these options.

These options only apply to the label that is at the top of the deck.

Undo undoes the last change you made if LazaLabl is able to do so.    Cut removes any text you 
have selected, and places it into the clipboard. Paste inserts the text in the clipboard at the current caret 
(text cursor) position, or as a replacement for any selected text.    Copy copies any text you have selected
into the clipboard.



Copy Top of Deck
This option copies the text of the label on the top of the deck to the clipboard.    You can then paste the 
text into a document you are processing with your favorite word processor.    This saves the effort of 
having to select the text in the label, and then use the Copy option.



Copy Preview
This option puts the current composition, including superimposition or any background labels, graphics, 
etc., into the clipboard, so you can paste it into another application.    The clipboard format used is the 
Metafile Picture.    If there is no superimposition and there are no background labels, the text of the 
composition will also be placed in the clipboard.



Clear
This option clears the text in the label at the top of the deck.    The text is copied to the clipboard so that it 
can be retrieved by pasting if you change your mind.

If the layer is a text layer,    the margins, font, color and text mode remain unchanged.    If the layer 
contains a graphic element, the contents are cleared and the layer reverts to being a shrink2fit text layer,
but the margins are maintained.

Use Clear after Clone from Topmost when you want to create a label with the same margins, font, color 
etc, as a the last label you created.



Go To Label #
If you know the number of the label in the deck that you want to recover, or its approximate location, 
LazaLabl will allow you to select that label by number, and find it immediately, without having to click 
through the entire deck.

If you select a label by number, but it is not the label that you wanted, you can use the Flip to Next or 
Flip to Previous options in the Control menu, or more conveniently, click on the left or right mouse 
buttons in the area below the deck, or press F7 or F8 to flip quickly forward or backwards through the 
deck until you locate the label that you want.    If the deck is too large for that to be practical, you can 
always go back and select the Go to Label# option and try again.

Selecting the Go to Label# from the Edit menu causes a Go-To dialog box to pop up.    Enter the required
label number, then click    OK or press ENTER.



Search
Choosing the Search option from the Edit menu brings up a standard Windows Search dialog box.    
Enter the word or phrase you want to search for in the edit box, then click on Find Next.    If the word or 
phrase is found on any of the labels in the deck it will be selected on the label at the top of the deck.    The
Search dialog box will remain displayed.

If you can not see the label at the top of the deck because it is obscured by the Search dialog box, you 
can move the dialog box out of the way.    Move the mouse into its title bar, press and hold down the left 
mouse button, and drag the dialog box out of the way.

If the word or phrase is not found, the Search dialog box will disappear, and a message box will pop up 
notifying you that all the labels were searched, and that the word or phrase was not found.



Replace
Choosing the Replace option from the Edit menu brings up a Search and Replace dialog box.    Enter the 
word or phrase you want to search for in the Find edit box, and the word or phrase to replace it with in the
Replace box.    Then click on the Find Next, Replace, or Replace All button as required.

If the word or phrase is found on any of the labels in the deck, the Search and Replace dialog box will 
remain displayed. 

If you can not see the label at the top of the deck because it is obscured by the Search and Replace 
dialog box, you can move the dialog box out of the way.    Move the mouse into its title bar, press and hold
down the left mouse button, and drag the dialog box out of the way.If the word or phrase is not found, the 
Search and Replace dialog box will disappear, and a message box will pop up notifying you that all the 
labels were searched, and the word or phrase was not found.



Frequently used Phrases

In most applications of LazaLabl, there will be words or phrases that you frequently put on cards and 
labels.    Examples would be:

your name
your company name
your address
your phone and FAX numbers
your internet address
the price of the item you sell most of

You can enter up to 10 such words or phrases into LazaLabl using the Frequently Used Phrases 
option of the Edit menu.

These words or phrases are then inserted into text you are typing simply by pressing the key 
combinations Ctrl+0 (zero) through Ctrl+9.

A dialog box will pop up.    First enter a number for the phrase you want to add or change.    Then enter the
required text.    You can then go on to add/change the text for other numbers.    Multiline text is allowed.





Control Menu
The following is a summary of the Control menu options

Start Another Label
Create a new label with default options at the top of the deck

Clone from Topmost
Create a new label at the top of the deck, copying the one currently at the top

Delete Current Label
Delete the label at the top of the deck

Undelete
Recover the label last deleted and place it on the top of the deck

Flip to Next
Switch to the next label in the deck

Flip to Previous
Switch to the previous label in the deck

Expose Layout
Move the deck so you can see the layout

Expose Label Deck
Move the deck back into view

Place Item using Keyboard
An alternative to the mouse!

Auto Layout
Transfer labels from the deck to the layout

Fill Sheet from Top of Deck
Duplicates the contents of the label at the top of the Deck over the whole sheet

Fill Sheet
Fill the whole sheet from the current deck

Empty the Layout
Clear any items placed on the layout

Refresh Layout
Synchronize the sketches on the layout with the deck contents

Preview
Show a preview of the card/label at the top of the deck

Margins
Show the margins tool



Start Another Label (Ctrl+A)
Choosing Start Another Label from the Control menu creates a new empty label/layer at the top of the 
deck.

The new layer will be set so that anything you type into it will be in the default font, in black.    You can set 
the default font from the Adjustments menu.    Its margins will be set to the full size of the items on the 
current chosen stock.    

If you want the font and margins of the new label to be the same as the last one you worked on, use the 
Clone from Topmost option described in the next section, then use Clear from the Edit menu.



Clone from Topmost (Ctrl+C)
Choosing this option from the Control menu creates a copy of the label that was previously at the top of 
the deck, and puts the cloned copy at the top of the deck.

All the details of the original label are copied, so the new label will get the same typeface, color, mode 
(WYSIWYG, Shrink2fit, Maximize, Bitmap, etc), and the same margins.

Use the clone option when the new label needs to have the same settings as the previous one, then just 
make the appropriate changes to the text, or choose Clear from the Edit menu and start the text from 
scratch.    This command combination can be invoked automatically by holding down the shift key while 
choosing the menu item, of by pressing Shift+Ctrl+C.



Delete Current Label
The label at the top of the deck is destroyed.    Actually its contents are transferred to the clipboard and 
held in reserve, so you can paste the information back onto another label if you change your mind.

You can use Delete then Undelete to change the position of an item in the deck.



Undelete
If you wish to change a layer's position in the deck by deleting and repositioning it, or if you have 
mistakenly deleted a layer, choosing the Undelete option from the Control menu will enable you to 
restore the most recently deleted layer to whatever position is at the top of the deck as it currently 
appears on the screen.

For example, if you have deleted layer #1 of 30 and wish that layer to be moved to position #12 of 30, go 
to layer #11 in the deck and choose the Undelete option.    The deleted layer will reappear as #12, and 
the succeeding layer numbers will each advance by one. 

Undelete will not return a layer to its previous position in the deck unless you are at the position where 
you did the delete, and the layer was not the first one.



Flip to Next
The layer at the top of the deck is moved to the bottom of the deck, exposing the layer underneath.    

The same effect can be obtained by positioning    the mouse outside the layer at the top of the deck, and 
to the left of the Layout, and clicking on the left mouse button, or by pressing the F8 or Ctrl+N key.

The current position in the deck of labels is indicated in the status panel at the lower left of the LazaLabl window.    This will say something like:

Label    3      of    5



Flip to Previous
Choosing the Flip to Previous option will recover the layer that is at the bottom of the deck and transfer it
to the top, covering the layer that had been on top previously. 

The same effect can be obtained by positioning the mouse outside the layer at the top of the deck, and to 
the left of the Layout, and clicking on the right mouse button, or by pressing the F7 key.

The current position in the deck of labels is indicated in the status panel at the lower left of the LazaLabl window.    This will say something like:

Label    3      of    5



Expose Layout
When using larger label sizes, or when you have many labels in the deck, the deck may obscure a part of 
the label-sheet layout on which you need to place a label.    Choosing the Expose Layout option from the 
Control menu will move the deck of labels away to the left so that the layout is clear.    Use Expose Label
Deck for the reverse operation.



Expose Label Deck
If you have shifted the deck away to the left to enable you to see all of the label-sheet layout, using the 
Expose Layout option of the Control menu,    this option allows you to move the deck back into view.



Place Item using Keyboard
Not all users are able or anxious to use a mouse.    The Place Item using Keyboard option provides an 
alternative.

Switching on this option temporarily disables most other operations.    When you have switched it on you 
can:

* Move a dotted highlight rectangle about on the Layout using the cursor control keys.
* Place the item at the top of the Deck on the layout at the currently selected position

by pressing the space bar.    If there is already an item there,    pressing the space bar
removes it.

* Shuffle through the deck by pressing F7 (back) or F8 (forward).
* Quit Place Item using Keyboard mode by pressing Esc.

See also Keyboard Interface for Musophobes.



Auto Layout
This option places the labels in the deck onto the label stock automatically, starting from the bottom of the
Layout, and starting at the current label in the deck.    If there are more labels in the deck than will fit on 
the sheet, the sheet is filled, then the process stops.    The label at the top of the deck becomes the next 
label available to be positioned, so you can repeat the process.

If you want to fill the whole sheet by repeating the items in the deck, use the Fill Sheet option of the 
Control menu.



Fill Sheet from Top of Deck
This option replicates the label at the top of the deck on all the elements of the current layout.    Any 
background layers are included.    Same effect as Fill Sheet if the Deck is superimposed.



Fill Sheet
Fill Sheet is similar in action to Auto Layout except that the Fill Sheet option will continue to pass 
through the labels in the deck, placing each on the sheet in order, until the sheet is full.    Use this, for 
example, to create multiple copies of the same label.



Empty the Layout
Choosing the Empty the Layout option will clear the label-sheet layout of whatever appears there.    
Empty the Layout does not effect the label group in any way, it simply allows you to clear the label-sheet
layout without having to resort to the slower method of clicking each label off individually.



Refresh Layout
The versions of the labels displayed on the layout sheet serve principally as reminders of which labels 
you have placed where.    They also attempt to give a reasonable impression of how the printed labels will
look.    However, in many cases the layout representations will involve the use of very small fonts, and the 
representation will not be exact.    For this reason, updating these representations is not regarded as a 
high priority requirement.

If you place a label on the sheet, then modify the same label on the deck, the previously placed version 
will not be visibly modified to reflect the changes.    The changes will however be incorporated when the 
actual sheet of labels is printed.    Any labels printed from the same item in the deck will be identical.

If you place more copies of a modified label on the sheet, the latest modification will be displayed.    But 
since the font or bitmap operations needed to display the miniature labels are relatively slow, previously 
placed versions are not updated.

If you want to see the layout sheet in as close a representation as possible to that which will be printed, 
use the Refresh Layout option from the Control menu.    All the labels on the layout sheet will then be 
redisplayed in their current form.



Preview
Shortcut Key F9

LazaLabl can produce very simple labels that can be printed with confidence as soon as they have 
been typed onto the label at the top of the deck.    It can also produce very complex compositions on 
labels, business cards, reply cards etc.    In complex cases it is usually necessary to have a "what-you-
see-is-what-you-get" view of the composition in order to get it correctly laid out.    This is the purpose of 
the Preview option.

Previewing is turned on by selecting Preview from the Control menu, or by clicking the  icon on the 
toolbar.    Once it is turned on it remains on while a number of other operations are executed.    Some 
operations that might make the preview inaccurate, or volatile, automatically turn it off.

In particular it remains displayed while cycling through the deck, adjusting fonts colors and margins, and 
adjusting scale.    File operations, label stock changes, and adjustments to the layout turn it off.



Margins
The labels in the deck can have margins set.    Margins can be set on all four sides, left, top, right, and 
bottom.    Margin adjustments can be made using the Margins Tool.    This is a small dialog box with four 
scroll bars, one for each margin, and a close button.    You can also adjust the margins by dragging them 
on the preview with the mouse.

The scroll bars are accompanied by numeric indicators which show the current position of each margin in 
thousandths of an inch.    These numbers can be used when it is required that several labels in the deck 
have equal or relative margin values set.    We also use these numbers here in the manual to describe 
typical LazaLabl operations.    The number at the top left refers to the top scroll bar, which controls 
the left margin.    The other number at the left refers to the left scroll bar, which controls the top margin.    
The number at the bottom right refers to the bottom scroll bar which controls the right margin.    The 
remaining number refers to the right scroll bar, which controls the bottom margin.

The margins tool is opened by selecting the Margins option from the Control menu, or the  icon on 
the toolbar.    Once it is open it can be left open and visible on-screen for as long as it is required.    
Adjustments to the scroll bars move the margins of the label/card at the top of the deck.    Moving the left 
and top margins generally moves the contents of the label right and down.    Movements of the right and 
bottom margins can constrain the contents within a smaller area or cut them off, depending on the type or
nature of the label.

If the label is in Shrink2fit or Maximize mode, the margins will define the area in which the text will be 
shrunk or maximized.    If however, the label is in WYSIWYG mode, any text or graphics which would be 
outside the set margins can simply be cut off.    Graphic objects can be scaled to the margins, and 
WYSIWYG text can be clipped (see Graphics Scaled to Margins and WYSIWYG Text Clipped to 
Margins under the Adjustments menu).

If the Preview option is active at the same time as the margins tool, the effects of modifications made 
using the margins tool are immediately visible in the preview.    However you should note that if you are 
working with relatively large bitmaps it will be faster to make major adjustments to the position of the 
image by dragging the margins rectangle on the preview using the mouse pointer.    If you move the image
on the preview in steps using the margins tool, the whole bitmap has to be redrawn for each step.    
However the margins tool may allow you to make more accurate adjustments than you can make by 
hand.



Make Group/Break up Group
This menu item varies depending whether the current layer (the layer at the top of the deck) is a group 
layer or not.    If it is not a group. the menu item will be Make Group.    If it is a group, the menu item will 
be Break up Group.

The Make Group option allows a set of layers in the deck to be made into a single group Layer - see 
Groups.

The Break up Group option allows an existing group to br broken down into it's component layers.





Adjustments Menu
The following is a summary of the Adjustments menu options

Default Font
Changes the font which LazaLabl uses for normal text

Scale Deck for 640x480
Scale Deck for 800x600
Scale Deck for 1024x768

Scale down the size of the deck and the preview (to fit them on the screen?)

Scale Deck Normally
Restore normal scaling

Bitmaps at Printer Resolution
Specifies whether bitmaps are to be printed at screen or printer resolution

Export Progressive Graphics
Forces JPEG files to be written as progressive JPEGs, and PNG files to be written interlaced

Render Bitmaps Transparently
Specifies whether bitmaps should be rendered so the white background parts are transparent.

Graphics Scaled to Margins
Use margin settings to scale imported graphic elements.

WYSIWYG Text Clipped to Margins
WYSIWYG text is chopped off by the margin settings

Strip Empty Lines from Imports
Controls the treatment of blank lines in ASCII imports

Test Mode Printing -
Print outlines round label areas

Use Custom Palette
Switch on or off use of the customizable color palette

Modify Custom Color
Change a color in the customizable color palette

Update Custom Palette
Save the current color scheme permanently in LazaLabl's initialization file

Hide Preview Sizing Box
Switches the dotted line elastic rectangle on the preview on and off

Set Bar Code Preferences -
Adjust bar code presentation options

Crop Marks
Causes the printing process to generate crop marks



Point Tracing
Allows a polyline or other points list to be specified by mouse clicks on the preview



Default Font

When you type text onto a label, LazaLabl will display the entered text in whatever is the currently 
specified font or typeface.    If you haven't done anything to change the as-shipped configuration, this will 
be Arial regular 10 point.

The font that appears when you start LazaLabl and type something onto the single blank label in the 
deck, if you have not set the font for that label,    is called the Default Font.

You can change the default font using the Default Font option.    Let's say you changed the default font to
Courier New 10 point.    Then if you reloaded a deck of labels that you typed in using the default font 
before, all of those labels will now appear in Courier New.    They will appear in the current default font, 
whatever it may be!    Note also that because Courier New has a different character spacing than Arial, the
text on those labels may now be too big for them.



Scale Deck - 

Scale deck for 640x480
Scale deck for 800x600
Scale deck for 1024x748
Scale deck normally

LazaLabl is intended principally to deal with a regular grid of rectangular areas on a larger 
rectangular sheet.    The extreme case of this is a letter size sheet with one row and one column, and a 
label about the same size as the sheet.    In practice the label can't be full sheet size.    Printers rarely 
allow printing right out to the edge of the sheet.    However 8" x    10" is normally feasible.

A user defined layout for this purpose is easily defined, in fact you will find one in the user-defined layouts 
of LazaLabl as-shipped.

On a standard VGA screen however, this layout will be too large to deal with.    It won't be possible to see 
all of the sheet to edit your text and it won't be possible to see all of the preview.

Full Sheet Portrait

Page width 8500 Page height 11000
Columns             1 Rows                 1
Label width 8000 Label height 10000
Left margin     250 Top margin         500
Left edge to left edge Top edge to top edge             

            0                 0

Full Sheet Landscape

Page width                    11000 Page height     8500
Columns             1 Rows                 1
Label width                  10000 Label height     8000
Left margin     500 Top margin         250
Left edge to left edge Top edge to top edge

            0                 0

For this reason, LazaLabl provides the capability to scale down the size of the deck and the preview 
by factors that accomodate the popular SVGA (Super VGA) screen resolutions.    The scaling options - 
Scale 640x480, Scale 800x600, Scale 1024x748, and Scale Normally, are provided in the 
Adjustments menu.    Scaling is not without its penalties.    The scale factors are designed to make a full 
sheet    label just workable with the specified screen resolution.    At those scales, 10 point text becomes 
difficult to read.    However, if LazaLabl is being used for the sort of job for which it is more 
appropriate than a word processor, a small poster for example, you'll probably be using larger fonts 
anyway.

Note that you are not obliged to use the scaling option which actually corresponds to your screen 
resolution.    If you are working with a 640x480 screen, and just need the scale reduced a little, try the 
1024x748    or the 800x600 options.    These may give sufficient reduction.



Bitmaps at Printer Resolution

By default, LazaLabl displays and prints bitmapped graphic images AT PRINTER RESOLUTION.    
Graphics printed in this way use a printer dot (or pixel) for each dot (or pixel) in the original screen image. 
This way when an image is printed you get high resolution, a good quality image.    However the printed 
image is much smaller - by a factor of 3 or more - than the image you saw on the screen when you 
created the bitmap or cut-and-pasted it from another application.    LazaLabl tries to shows things as 
they will be printed, so the image you see in the preview or on the layout will be smaller too.    It will in fact 
be scaled down, and may suffer in quality as a result.    What you see on the screen will be poor quality, 
and what you get printed will be high quality.

It may well be, however, that what you want printed is something about the size of what you saw on the 
screen.    In that case,    look at the Bitmaps at Printer Resolution option of the Adjustments menu.    If 
it is checked, then printer resolution scaling is being used, and you can click that menu item to turn it off.   
Then what you see on the screen will be at full screen resolution size.    What you see on the screen will 
be good quality, and what you get printed will be composed of larger and more grainy dots - jaggies etc.

For best results with bitmapped graphics, design your graphics at about 3 to 4 times the final required 
size, and use printer resolution.

The scaling information is stored with graphic object layers that contain bitmaps when they are written to 
a file, so when they are recovered from the file they will be displayed and printed at the scale you 
selected.



Render Bitmaps Transparently
It is possible in some cases in Windows to paint one bitmapped graphic picture on top of another in such 
a way that you can "see through" the white bits of the top bitmap, where you will see the corresponding 
parts of the picture underneath.

LazaLabl prints complex compositions by printing successive layers one on another,    so sometimes 
you might want to see through an imported bitmapped graphic.    It should often be possible to do the 
transparency trick on the screen,    but some printers don't get it right.    The default behavior is to render 
transparently.    If what you print does not look like what you saw on the screen, switch this option OFF.    
The screen preview should then be the same as what you get printed.

Transparency is not supported for bitmap images using more than 256 colors.



Export Progressive Graphics
This option controls the way that bitmapped graphic export files are constructed.    If the Export 
Progressive Graphics option is selected,    a form of graphics file is generated that can be displayed by a
viewer, or a web browser, as a sequence of approximations leading to the full image.    This is useful when
the image is being loaded over a slow communications link.

If you are exporting a JPEG file,    this option (if selected) causes LazaLabl to store a Progressive 
JPEG file.    If you are exporting a PNG file,    the exported file is interlaced.      GIF files are not effected 
(LazaLabl may not support GIF files in future).



Scale Graphics to Margins
Inevitably there will be times when you have no control over the size of a bitmapped graphic item, and its 
original size is just plain unsuitable for what you want to do.    You may also want to scale such a graphic 
image to produce an eye-catching result.    Metafile graphics can generally be scaled freely with little or no
degradation in quality.

LazaLabl allows you to scale graphic images, regardless of the Bitmaps at Printer Resolution 
setting.    Selecting the Scale Graphics to Margins option enables such scaling.

When you select this option, the graphic image will be scaled to fit the rectangle defined by the current 
margin settings.    If this option is not selected,    graphic objects are clipped by the margins if the margin 
settings are smaller than the object.

When this option is selected,    graphic object specifications which contain measurements, e.g. polygons, 
have the measurements interpreted as relative to the rectangle defined by the set margins.    The width of 
that rectangle is taken to be 1000 units, and the height 1000 units.    When this option is not selected, 
measurements are taken as 1/1000ths of an inch.

The scaling information is stored with graphic object layers when they are written to a file, so when they 
are recovered from the file they will be displayed and printed at the scale you selected.



WYSIWYG Text Clipped to Margins
Normally, changing the margins for WYSIWYG text either just moves the text, according to the text 
orientation,as follows:

Orientation Margins that Move the Text

normal, rotated left, top
up left, bottom
down right, top
inverted right, bottom

or has no effect.

Selecting the WYSIWYG Text Clipped to Margins option from the Adjustments menu causes the other 
two margins to chop off the text so none of it appears outside the box formed by the margins.

You can use this to make multicolored text.    Using superimpose, or background, create a layer of text, 
then clone it.    Change the color of the second layer, then select the WYSIWYG Text Clipped to Margins 
option, and adjust the margins for the second layer to get the effect you want.

Here the first layer is black.    The second - cloned - layer is red,    and the bottom margin has been moved
up so that only the top of the red text is showing.



Strip Empty Lines from Imports
Data imported from a database system will often contain blank fields or items, for example:

"John Doe","","PO Box 1","Anytown, NJ 07000"

Here the first address field is blank.    If LazaLabl comes across a record like this it will normally print 
it as follows:

John Doe
PO Box 1
Anytown, NJ 07000

not as:

John Doe

PO Box 1
Anytown, NJ 07000

That is, if LazaLabl is merging, and finds that a particular line is empty, it will simply ignore it.    
Looking at it another way it will strip out blank lines.    This behavior is controlled by the Strip Empty 
Lines from Imports option of the Adjustments menu.    Normally stripping is turned on - the menu item 
is checked.    If you want the blank lines left in, turn it off.    This will be the case, for example, if you want 
to format the information on the label or card using line spacings and tabs.

However, suppose you want an effect like

Doe Industries Inc
PO Box 1
Anytown, NJ 07000

Attention J. Doe

Here an empty line is required, but LazaLabl will strip it out.

For this reason, LazaLabl asks a question when the Strip Empty Lines from Imports option is 
being switched on.    It will ask "Remove only completely empty lines?".    If you answer Yes to this 
question, then lines that contain spaces or tabs won't be stripped out.    Answer Yes to get effects like that
shown above, and put a space or tab in your merge template in the blank line you want preserved.

LazaLabl remembers the setting of this adjustment in its initialization file.



Test Mode Printing

If Test Mode is selected, LazaLabl places a bounding rectangle of the size specified by the current 
layout around each label it prints.

You can use this option to check that the sheet layout you have selected (the one showing in the right 
hand side of the LazaLabl window) corresponds to the actual label sheet you have available, without 
wasting any labels.    Select Test Mode and print a few labels onto a piece of plain paper.    It will then be 
a simple matter to compare the actual label sheet to the printout to check if the positions of the printed 
boxes and the actual labels coincide.    You can also use test mode to get an impression of how your 
finished product will look, without wasting cards or labels.

Don't forget to turn Test Mode off before you print the real thing - you probably don't want a black border 
round your labels!



Use Custom Palette
The perception of colors is highly subjective.    Some people prefer bright primary colors, others prefer 
more subtle pastel or muddy colors.

LazaLabl's standard palette is a "wash" across the spectrum.    Colors are distributed evenly about 
the three dimensional space (color cube) with axes representing red, green and blue.    This is a 
reasonable compromise, but will not suit everyone.    An obvious case is all of those users who use a 
normal black-toner laser printer.    In this case the most useful color palette would be one consisting of 
many shades of gray.    Other users may have a preference for some particular corner of the color cube.

LazaLabl    assists these users by providing an alternate color palette.    The individual colors of this 
second palette may be adjusted by the user.    The alternate palette is set initially to a general purpose 
color selection that places more emphasis on graded shades and rather duller colors than does the 
standard palette.    Alternatively a palette consisting entirely of shades of gray can be chosen as the 
alternate palette when LazaLabl is installed.

Selecting the Use Custom Palette option from the Adjustments menu causes the existing palette to be 
closed.    The new palette is then set up, and any display elements are re-displayed to allow them to 
adjust to the new palette.    LazaLabl remembers the setting of this option in its initialization file.

Selecting the Use Custom Palette again switches back to the standard palette.



Modify Custom Color
This option allows the user to modify the currently selected palette color.    It is only enabled if the Use 
Custom Palette option is selected, and the palette is turned on.

A dialog box will appear which allows adjustments of the red, green, and blue levels of the currently 
selected color using three scroll bars.    The selected color in the palette and in the preview (if it is turned 
on) will change as you make adjustments, so you can judge the effect you have achieved.

If you have modified one or more palette colors,    LazaLabl will save a copy of that particular custom 
color scheme in the .LZG file when you save your work.    If you don't save your work the color 
customization will be lost when you exit LazaLabl unless you explicitly save the changes using the 
Update Custom Palette option of the Adjustments menu.    You do not normally need to do this.



Update Custom Palette
If you have made modifications to the customizable color palette using the Modify Custom Color option, 
you can save the new color scheme by choosing the Update Custom Palette option.

Such modifications are made in the initialization file - LAZLAB.INI, and are permanent.    Don't use this 
option unless you are reasonably certain that your customization will provide a more generally useful, 
starting point color selection than the one you had before.    Remember you can make detailed color 
adjustments for individual LazaLabl files, and the color scheme will be saved with the file.

Note that you can also modify the custom palette by editing the initialization file - LAZLAB.INI - which the 
installation program placed in your windows directory.    The [palette] section of the initialization file should
contain 25 rows of 15 numbers in the range 0 to 255.    These are treated as 5 triplets representing the 
RGB (Red, Green, Blue) values of 5 colors in a palette row.    To get back to the as installed condition, 
simply re-install LazaLabl.    This will not effect your existing files, but do back them up in case of 
some mishap.



Hide Preview Sizing Box
This option allows you to turn off the dotted line "elastic rectangle" shown on the preview.    You may want 
to do this to get a good uncluttered view of your composition.

The menu item is checked if selected.    selecting it again turns it off, and the elastic rectangle reappears.

You can also switch it on and off by holding down the Ctrl key and left-clicking on the preview area.



Set Bar Code Preferences
If you have the optional Bar Code module this option will be available.    If you choose this option the Bar 
Code Preferences dialog box will pop up to allow you to adjust the details of the bar code rendering.    
See the Bar Code option of the Options menu for details.



Crop Marks
If you need to make cards or labels out of full sheets of stock,    it may be helpful to have crop marks to 
guide the cutting process.

Crop marks can't be drawn reliably for all layouts because of the fact that most printers have finite non-
printing margins, and these vary from printer to printer.    If the layout design goes right up to or over these
margins, the outer crop marks can not be shown.    Also if the panels of the design don't have spaces 
between them, the inner crop marks can't be drawn.

Within these limitations, LazaLabl will attempt to draw crop marks on its printed output if the Crop 
Marks option of the Adjustments menu is selected.



Point Tracing

If you need to draw a polygon or a polyline set, and you can do it well enough by drawing the point 
positions with the mouse pointer,    the Point Tracing option of the Adjustments menu will allow you to 
do it.

When this option is turned on, the sizing rectangle on the Preview is turned off.    Clicking on the Preview 
with the mouse pointer will place single pixel black dots in the preview area.

When the option is subsequently turned off, the points are removed from the preview, and a list of the 
point coordinates is placed in the layer at the top of the deck.    You can add a first line to define the sort of
figure you want drawn.





Stock Menu
The following is a summary of the Stock menu options

LazaLabl  's Defined Layouts  
Choose a pre-defined card/label layout

Current Stock Name
Reports the name of the current layout

Add New User Layout
Define a new layout

Modify User Layout
Modify a user defined layout

Delete User Layout
Deletes a user defined layout



LazaLabl's Defined Layouts

The first section of the Stock menu (the entries before the Current Stock Name option) shows the card 
and label layouts for which LazaLabl has layout definitions.    Most of these will name the 
manufacturer, and indicate whether they refer to label or card sheets.    However, in here in the manual we
can't be dogmatic about this, since these menu options are set up by entries in LazaLabl's 
initialization file, and this may have been modified by particular distributors of the product.

There is an exception.    The standard menu contains the option User Layouts, and the latter option 
should always be there.

The standard menu also contains an item Generic/Photocopy Style.    Generic/photocopy style sheets 
are characterized by having no margins and no spacing between the labels.    They are not really very 
suitable for laser and ink-jet printers, since these printers do require margins.    On the other hand, they 
may be all you have around, so LazaLabl does its best to adjust what it prints on them to allow the 
margins required by your printer - see the notes in Appendix C.    

If you are buying labels from scratch, buy the ones with margins that are specifically intended for use with 
laser and/or ink-jet printers.

The User Layouts option gives you access to layouts which you have defined for yourself.

Selecting one of these options    (??? through User Layouts) causes a list box to pop up that shows the 
label or card sheets available in that category.    Once again we can't be dogmatic, but the list box entries 
for specific manufacturers products should give information such as the product number, the intended 
use, and the label or card dimensions.

In the case of the User Layouts option, the text which appears for each item in the list box will be the title
you gave it when you designed the layout.

You can choose a layout from the list in the usual ways for a list box.    Double click on an item, or click an 
item then click OK, or use the cursor up/down keys to select an item then press ENTER.    If there are 
more items than will fit in the box, there will be a scroll bar to allow you to access the ones you can't see.

If you just wanted to look, and don't want to change the current layout, click CANCEL, or press the ESC 
key.

When you choose a layout in this way,    the layout at the right of the LazaLabl window is repainted to 
show the pattern of labels or cards you selected.    The size of the cards/labels in the deck is adjusted 
accordingly.    Changing the layout does not lose the information stored on the cards in the deck.    It is all 
still there, but it may get moved about.

If you are in doubt that the layout matches a sheet that you have in hand,    select Test Mode from the 
Options menu, then use the Fill Sheet option from the Control menu to fill a sheet with labels.    Print the
labels on a piece of plain paper, then hold the paper and the label sheet up to the light to see if they line 
up.    Using Test Mode will cause a box to be drawn around each label.    Don't forget to turn Test Mode off
again before you print on the actual label sheet!



Current Stock Name
If you have to load the printer you may wish to remind yourself of the name and product number of the 
current layout.    Selecting Current Stock Name from the Stock menu pops up a message box to provide 
this information.



Add New User Layout
This option allows you to define layouts of your own design.    Use it if you have label stock which is not 
covered by existing menu items.    For example, although LazaLabl is primarily designed for use with 
laser and ink-jet printers, you can use it with a dot-matrix printer.    However you will have to set up a 
layout for your pin-feed label stock first.

You can also use this facility to design sheets that may not actually correspond to pre-cut label or card 
sheets.    If you print on plain paper or card and guillotine the sheets up afterwards you can use LazaLabl to create badges, price tags, invitations, tickets etc of any size you choose.

When you select the Add New User Layout option from the Stock menu,    a dialog box will pop up to 
allow you to enter the required layout definition information.

Five rows of two columns of numbers are required.    The first row describes the paper size, which will 
often be 8.5" by 11".    You enter the measurement in decimal inches, or decimal mm if LazaLabl is set up 
for metric units.

The next line in the dialog box requests the number of columns of labels, and the number of rows.

The following line asks for the width and height of each label.

A - left margin
B - top margin
C - label width
D - label height
E - left edge to left edge
F - top edge to top edge

The next line requests values for the left and top margin.    Always allow margins - printers can't print up to
the edge of the sheet.    To be safe on most printers allow 0.5" top margin and 0.25" left margin, in portrait 
orientation.    In landscape orientation the margins are reversed - 0.25" top and 0.5" left.    The margins 
could be set much wider.    If you were designing a layout to print addresses on envelopes in the 
conventional position you would use the margins to place a single label in the center of the envelope 
(sheet).

The last line of numbers requests the distance from the left edge of a label in a row to the left edge of the 
next label in the same row, and the distance from the top edge of a label in a column to the top of the next
label in the same column.    If you are designing sheets to be guillotined it will probably be appropriate to 
make these measurements the same as the label width and height.

When you have finished entering the measurements be sure to enter a name for the layout in the "Name 
to use in menu" edit box at the bottom of the dialog box.    Enter a clear descriptive name that you or other
users will be able to relate to in the future.

When you are through, click on OK with the mouse.    If you don't like the design you made, select 



Cancel.

To select the layout after you have designed it, choose the User Layouts option from the Stock menu, 
then choose the layout by name from the displayed list box.



Modify User Layout
Use this option to make changes to a layout you have already defined or partly defined.    When you 
select the Modify User Layout option from the Stock menu, a list box pops up to allow you to choose the
layout you wish to modify, by name.

When you have chosen one of the user defined layouts, the layout design dialog box pops up to allow you
to make modifications.    Your entries should be as described in Add New User Layout.



Delete User Layout
The Delete User Layout option allows you to remove a layout which you defined using Add New User 
Layout.

When this option is selected a pop-up list appears.    Selecting a layout name from the list causes that 
layout to be removed.    Use this option with care - deleted layouts can't be restored - you will have to 
define them again.





Options Menu
The following is a summary of the Options menu options

Font
Change the font of an entire layer or the currently highlighted text

Color Palette
Change the text color for an entire layer or of the currently highlighted text

Shrink2fit
Change the layer to Shrink to Fit mode

Maximize
Change the layer to Maximize mode

Scaled Text
Change the layer to Scaled Text mode

WYSIWYG
Change the layer to What-You-See-Is-What-You-Get mode

Justification
Sets the justification mode (left, center, right) for the layer

Text Orientation
Control text orientation in WYSIWYG mode

Serialized
Switch Serial Number mode for a layer on and off

Postal Bar Code
Set the layer to generate a USPS PostNet bar code

Time Stamp
Switches Time Stamping for the layer on and off

Graphic Object
Select a graphic object mode for the layer

Imported Picture
Switch the layer mode to Imported Picture and off again

Line
Switch the layer mode to Line Graphic and off again

Rectangle
Switch the layer mode to Rectangle Graphic and off again

Ellipse
Switch the layer mode to Ellipse Graphic and off again

Polyline
Switch the layer mode to Polyline Graphic and off again



Character Outline
Switch the layer to Character Outline and off again

Program Layer
Switch the layer mode to Program and off again

End of Group
Switch the layer mode to Group End and off again

Background
Switch Background mode for a layer on and off

Non-Printing Template
Make a layer visible but non-printing

Superimpose
Switch superimposition on/offsuper



Font
Choosing the Font option from the Options menu, or the corresponding icon from the toolbar causes a 
standard Windows Choose-Font dialog box to appear.    When you choose a font, it is applied to any text 
in the layer at the top of the deck that has been highlighted.    If no text has been highlighted, all the text in
the layer at the top of the deck is changed, and the layer now has its own font.

There is a second font icon (the vertical double headed arrow with the small 'f') which can be used to 
change the size of the font on the current layer, or of the currently highlighted font.    Clicking this icon will 
reduce the font size by 5% or one screen pixel, whichever is the greater.    Holding down the Shift key and
clicking it will increase the font size correspondingly.

A more detailed description of how LazaLabl handles fonts is in order. When you type text onto a 
layer, LazaLabl displays the text in some specified font or typeface.    If you haven't done anything to 
change the as-shipped configuration, this will be Arial regular 10 point.

The font that appears when you just start LazaLabl and type something onto the single blank layer at
the top the deck, is called the default font.

You can change the default font from the Adjustments menu, using the Default Font option.    Let's say 
you changed the default font to Courier New 10 point.    Then if you reload a deck of label which you typed
in before, using the default font, all those labels will appear in Courier New.    They are in the now current 
default font, whatever it may be!

Now suppose that with one of those labels at the top of the deck, you select the Font option from the 
Options menu, or equivalently you click the font icon on the toolbar.    A font dialog box pops up, that 
allows you to choose a new font, or point size, or style (bold, italic etc) and possibly a color, or some 
combination of these features.    When you press OK to accept your choice of font characteristics, all the 
text in the label at the top of the deck will be redisplayed using that font.

If at that point you change the default font back to Arial 10 point, using the Default Font option from the 
Adjustments menu, all the other labels which had appeared in Courier New will revert to being Arial, 
since that is now the default font again, and they have as their font attribute the default font.

However, the one label that you singled out and chose a new font for, using the Font option, will remain in
the font you selected.

That label now has ITS OWN FONT.    It is no longer affected by the setting of the default font.

These are some of the ways in which the font that is associated with each label are determined.    
However, there is more.    If you highlight some part of a label's text and then use the Font option from the
Options menu, or click the font icon on the toolbar, and choose a font, ONLY THE HIGHLIGHTED TEXT 
WILL BE AFFECTED.    You will in fact have picked out a part of the text in some font other than the one 
that is normally associated with that label.

You can use up to 15 different fonts to pick out separate parts of the text within a label.    'Different' in this 
context means differing in font name or point size or style (bold, italic etc).    Actually there are 16 font 
"slots", but one of these is used to note the label's own font.

One limitation which you have to accept when you pick out parts of the text in this way is that the line 
spacing will be determined by the largest font and point size combination in any particular line.    This is 
not an absolute limitation.    LazaLabl allows you to superimpose the contents of multiple labels.    
Mixing fonts within a label you could get an effect like



    one
    two

    three four
But using superimposition you can get effects like

Superimposition is little if any more work, but much more flexible.    Let's assume in this case that the one,
two, three text was on one label, and the four text on another.    The margins tool could then be used to 
move the word four with respect to the other two words with considerable precision.    See the 
Superimpose and Background options of the Options menu.

A word of warning.    15 different fonts are usually more than enough to create special effects within a 
single block of text.    For this reason LazaLabl doesn't slow things down by eliminating from its list for
that layer those fonts you tried and subsequently decided you didn't like.    If you get a message to the 
effect that only 16 fonts are allowed per label, it is because the label has registered fonts that you tried 
out, but are not actually using.    If you save your work and then restart from the file, the unused fonts will 
have been eliminated.

Remember that by convention, typefaces displayed on the screen are about 1.2 - 1.5 times bigger than 
the corresponding type on the printer.    This is because the resolution of screens is not usually as good as
the resolution of a printer, and because we tend to view a screen from a greater distance.    Bear this in 
mind when you choose a typeface.    If in doubt, print a few labels on plain paper to get the feel of the 
different fonts you have available in your Windows installation.

Additional TrueType fonts are available at quite modest prices from    many manufacturers.    Numerous 
freeware fonts are also available on bulletin boards etc.



Color Palette

LazaLabl has its own palette of 125 colors which can be brought into play on monitors capable of 
displaying 145 or more palette colors, via the Color Palette option of the Options menu.    When the host 
system does not support this feature this menu item is disabled.    To conserve memory for users who 
don't use color, or choose only to use the 20 standard colors provided by Windows,    the palette is only 
created when it is specifically requested or when the user loads a LazaLabl file (a .LZG file) that 
specifies palette colors, or a color bitmap.    Choosing the Color Palette option when the palette is visible, 
hides the palette, but it remains in effect.    To show it again select the Color Palette option once again.

The palette is used by clicking on the color required.    A panel at the bottom of the palette shows the last 
selected color, and the selected color box is also outlined.    Selecting a color effects the label at the top of
the deck in one of two ways.    If a portion of the text has been highlighted, the highlighted text is set to the
requested color.    If there is no highlighted text, all the text in the label is set to the requested color except 
for any sections that were previously highlighted and colored.    The text of a label can thus be regarded 
as falling into two categories.    Default text, which can be colored as a whole, and text which is 
differentiated from the rest by a separate color, or actually by a separate color or a separate font, or both.  
You can change the general color of a label's text as often as you like, but there is a limit of 15 other 
highlight colors per label.    (See the notes on limitation of the number of fonts under font.)

The default color, that is the color of text that you have not explicitly set, is black. 

If LazaLabl 's palette has not been activated, it is possible to select colors from the font choice dialog 
box.    In this case your choice is limited to the 20 standard Windows colors.    This facility will be quite 
adequate when only simple colors are required, and it provides consistency and compatibility with 
LazaLabl version 1 files.

The palette can be switched between LazaLabl's fixed color palette, and a customizable palette.    
See Use Custom Palette under the Adjustments menu.



Shrink2fit
The text in the labels on the deck is not necessarily what will appear on the corresponding label or labels 
when they are printed or when they are previewed.    The actual appearance of the labels is controlled by 
the label's mode.    Modes are selected from the Options menu. Shrink2fit is a mode.

This option is the default behavior when LazaLabl prints labels etc.    The text you have entered in the
layer at the top of the deck will be used as-is in terms of typeface, character size, and style, unless it is 
too large to fit on the label.    In the latter case, the typeface and style will be preserved to the extent that 
this is possible, but the characters will be reduced in size so that the entire label text will appear on the 
label.    If shrinking occurs, the font match may not be exact, it may be that there is no exactly-matching 
smaller font available.    However if you have chosen a TrueType font this should not be a problem.

The printed text also differs from the text on the layer at the top of the deck, in that the printed text will be 
centered on the label.    The centering will be such as to preserve the normal appearance of an address, 
that is centering of the whole text with overall left justification, not of individual lines, for example:

not

If the label in question has margins set at left, top, right or bottom, these are regarded as defining a 
bounding box.    The text will be centered and shrunk to fit within the box formed by the margins.

Note that there is a limit to the extent to which characters in any font can be shrunk, both in practical and 
absolute terms.    At some degree of shrinking they will lose enough detail that they become illegible, and 
in the limit, the smallest they can be made is one pixel on whatever display device is in use.    
Consequently, it you push it, LazaLabl may occasionally tell you that a font can't be shrunk to fit.    
Sometimes it will qualify this by saying it may print OK.    Printers generally have better resolution than the
screen.

You do not need to select an option explicitly to achieve the shrink to fit behavior.    This is LazaLabl's 
default mode.

When LazaLabl stores labels in a file the mode is stored with the label text, font, margin, and color 
information.    So if you first create a label in    Shrink2fit mode, then recover it from a file and print it 
again, it will be printed in Shrink2fit mode without any special action on your part.



WYSIWYG
The text in the labels on the deck is not necessarily what will appear on the corresponding label or labels 
when they are printed or when they are previewed.    The actual appearance of the labels is controlled by 
the label's mode.    Modes are selected from the Options menu. WYSIWYG is a mode.

Selecting this option instructs LazaLabl to print the text on the label just as you have entered it in the 
layer at the top of the deck.    The only adjustment made will be to scale the point size to compensate for 
the conventional difference in the size of the text on the screen versus the size of the text when printed.

If the text is too large for the label it will be clipped to size so that text does not flow over onto an adjoining
label.

Setting margins for the layer effects the output as follows.    If left and top margins are set they move the 
WYSIWYG text right and downwards respectively.    Right and bottom margin settings are ignored unless 
the WYSIWYG Text Clipped to Margins option of the Adjustments menu is selected.    In the latter case, 
the text is clipped to the set margins.

Selecting this mode will apply it only to the label that is at the top of the deck when the selection is made.  
If you change your mind you can always change the label back to one of the other options, Shrink2fit,    
Maximize, etc.

When LazaLabl stores labels in a file, the mode is stored with the label text, font, margin, and color 
information.    So if you first create a label in    WYSIWYG mode, then recover it from a file and print it 
again, it will be printed in WYSIWYG mode without any special action on your part.



Text Orientation
Choosing the Text Orientation option from the Options menu causes a sub-menu to pop up that allows 
you to choose from a selection of text orientations.

Text orientation only effects labels that have the WYSIWYG mode,    and in fact if you select one of the 
text orientation modes you also select WYSIWYG.      If you choose another mode the text will revert to 
normal orientation.    The orientations are as follows:

Normal - Text left to right
Upwards - Text from bottom to top
Downwards - Text from top to bottom
Inverted - Text upside down, right to left
Rotated - Allows arbitrary rotation (slanting) of the text
Circular - Causes the text to be printed around an ellipse.

Setting margins for the layer effects the output as follows:

Orientation Move Text Using

normal, rotated, circular left, top
upwards left, bottom
downwards right, top
inverted right, bottom

In each case, the other two margins either have no effect,    or if the WYSIWYG Text Clipped to Margins 
option of the Adjustments menu is selected, they clip the text to the rectangle formed by the set margins.

Rotated text is rotated about the corner formed by the left and top margins.    The default rotation for this 
mode is 30 degrees slant downwards.    This serves quite well when the rotation is being used as an 
attention-getter.

Other rotation angles are specified by a .r (rotate) command at the start of the text - e.g.

.r135 Rotated 135

the .r135 command causes the text to be rotated anti-clockwise through 135 degrees. 



Negative rotation values are acceptable.

The Circular option causes the first line of text on the layer/label to be written around the circumference of
an ellipse whose shape is set by the margins.    The text starts by default at the 180 degree position, 
measuring anti-clockwise - e.g.

To start it somewhere else use a .r    (rotate) command at the start of the text - e.g.

.r90,200 1234567890123456

Here the text starts at the 90 degree position.    The number (percentage) after the comma adjusts the 
spacing of the characters.    The default value - if there is no second number - is 150%.    200% spreads 
the characters out more.    The space between the .rxxx command and the actual text is required.



Maximize
The text in the labels on the deck is not necessarily what will appear on the corresponding label or labels 
when they are printed or when they are previewed.    The actual appearance of the labels is controlled by 
the label's mode.    Modes are selected from the Options menu. Maximize is a mode.

Selecting this option causes the text in the edit box to be printed on the label in the largest version of the 
selected font that will fit on the label with 5% top and bottom margins.      For example, if the contents of 
the edit box were:

then with the Maximize option selected for that label, the label would be printed as:

If the label in question has margins set at left, top, right or bottom, these are regarded as defining the 
effective size of the label.    The text will be centered and maximized within the specified margins.

Note that, as is the case with the Shrink2fit option, the text is centered on the label.    The size of the text 
printed includes the external leading specified for the font, and it also allows for downcomers in letters like
'g' and 'y' whether there are any there or not..    If it looks as if the output could have been bigger, this is 
probably due to these factors.    To get the absolute maximum size on the label, use WYSIWYG mode and
adjust the position of the text with the margins tool.

When LazaLabl stores labels in a file the mode is stored with the label text, font, margin, and color 
information.    So if you first create a label in    Maximize mode, then recover it from a file and print it 
again, it will be printed in Maximize mode without any special action on your part.



Graphic Object
This option raises a pop-up menu to allow you to choose a graphic object type.    These are:

Imported Picture
Line
Rectangle

(and rounded rectangle)
Ellipse

(including arc, chord, and pie)
Polyline
(including polygon, and connected and disconnected polylines)
Character Outline



Imported Picture

Pictures or graphics can be imported into LazaLabl's deck in two ways.    A bitmapped graphics file or
a .WMF (placeable metafile) can be imported directly, or a graphic object can be cut from another 
Windows application and pasted onto the label at the top of the deck.    Graphic elements should be 
combined with text using Background mode or Superimpose.    Graphics and text can't be mixed on a 
single layer in the deck.

As is the convention in LazaLabl, the picture is represented in the card at the top of the deck by text 
which describes it, in this case a file name.    So Imported Picture is a mode, like Shrink2fit, Maximize, 
Scaled Text and WYSIWYG.

Importing a file directly

To include an existing graphic image from a file, choose Imported Picture from the options menu or click 
on the corresponding toolbar icon.    A file-open dialog box will pop up to allow you to choose from a 
number of file types. 

.BMP - Windows device independent bitmap

.GIF - Compuserve GIF format
(support for this format may not be continued)

.JPG - JPEG bitmap graphic file

.PCX - PCX bitmap graphic file

.PNG - PNG Portable Network Graphics bitmap file

.TIF - Aldus TIFF format bitmap file

.WMF - Windows Metafile

Adjust the file type and directory if required, then choose a filename in the usual way.    LazaLabl will 
check out the specified file.    If it can make sense of it, the file name will appear in the label at the top of 
the deck, and the label type in the status panel will change to Graphic.

LazaLabl won't convert all graphics files,    just regularly formatted ones in the popular configurations. 
If this doesn't work try converting the file to .BMP using a more specialized graphic file format convertor.    
BMP and PCX files that won't read should be opened in Windows Paint,    and saved from that.    This will 
usually correct any problem

Alternatively, if you are sure what file you want to use, type the file name into the label at the top of the 
deck directly, and then select Imported Picture from the options menu or click on the corresponding 
toolbar icon.    If you don't type in a file name extension, .BMP will be assumed.    LazaLabl will look 
for the file first in its home directory, which you specified when LazaLabl was installed.    It will then 
look in the Windows directory.    If the required file isn't found in either of these places, LazaLabl will 
display a warning error message, and the label at the top of the deck will revert to a default Shrink2fit text 
state.    All you will then see if you print the label is the text of the (incorrect) file name.

Moving and sizing the picture

The position of the graphic object is determined by the left and top margins.    The size of the object is 
determined by the right and bottom margins.    The object may be clipped to size, or scaled, depending on
the setting of the Graphics Scaled to Margins option of the Adjustments menu.    You can move it or 
size it by adjusting the margins with the Margins Tool, or by dragging the margins on the Preview with the 
mouse pointer.

Pasting pictures from the clipboard



If you have cut a graphic image from another application, you can paste it into LazaLabl.    The label 
at the top of the deck should be empty.    If it already 'contains' a graphic image, LazaLabl will 
produce a warning message, and will decline to paste the item from the clipboard. If it contains text you 
will simply lose whatever text you had typed in.

At this point a temporary file name will be written onto the label at the top of the deck.    This name will be 
used for the file name of the graphics file when you save the deck of cards/labels.    It will be of the form 
"LL1543.ext" - two capital 'L's and a four or five digit number.    The extension - ext - will be either .BMP 
or .WMF, depending on what clipboard format was available.    We will return to it momentarily.    First 
though at this point it will be good to preview the picture you have pasted into the label.    Choose Preview
from the Control menu, or click the preview icon on the toolbar.    If the graphic in the preview is not what 
you wanted or expected, simply choose Imported Picture option again, to cancel that mode.

If you are happy with the image, its a good idea to change the file name in the label at the top of the deck 
so that it is meaningful for the picture you have pasted.    Otherwise when you clean up your hard disk you
won't remember what the file is.    If you provide path information in the file name, that path will be used.    
If you dont, LazaLabl's own directory will be used.    Don't change the extension.    If you do so, 
LazaLabl won't be able to read the file back correctly.

The name you provide will then be used to name the file when you save the deck.    If you don't save the 
deck the graphic object is simply junked.

Bitmapped graphics and color

Selecting a color from the palette will change any elements of the imported picture that were originally 
black, to the color you select.    This is useful for adding color to older black & white pictures.

If LazaLabl detects a 256 color bitmap, or a metafile that uses a palette it activates its own palette 
before it attempts to extend the palette to deal with the bitmap colors.    As a result the colors of the 
displayed 256 color bitmap may be slightly distorted from those you will see in a context where Windows 
only has the bitmap color requirements to satisfy.    The advantage here is that you can still use the whole 
range of text colors that LazaLabl provides.    The image should be correct when printed.

Graphics does and don'ts

Remember that bitmapped graphics eat up memory.    Don't expect to be able to create as many labels 
with bitmapped graphics in a deck as you can with text.    The same considerationn applies to a lesser 
extent with metafile graphics.

Remember also that scaling bitmapped graphics compromises the quality of the printed output.    For the 
best results, design for printer resolution, and avoid adjustment of graphics size by scaling to the margins.
Avoidance of scaling is particularly important with colored images where the color has been achieved by 
dithering (use of a pattern of several different colored dots to simulate a color).    Scaling dithered colors 
often produces an appearance similar to tartan, where the regular pattern of dots is broken by the need to
remove rows or columns of dots to match the scaling factor.

Canceling graphics mode

If the label at the top of the deck is in picture mode, selecting the Imported Picture option from the 
Options menu again turns the picture mode off.    The layer reverts to Shrink2fit.



Background
Background can be regarded as another mode for a layer, like Shrink2fit, WYSIWYG, Maximize, and 
Graphic Object.    It controls how the layers get printed or displayed.    It's different from the others though, 
since it specifies that the layer is to be combined with some other layer or layers in the deck.    Use 
Background or Superimpose to combine graphic elements with text.    Text and graphics can't be mixed on
the same card/label in the deck.

The layer at the top of the deck is put into background mode by selecting the Background option from the 
Options menu.

More specifically, when LazaLabl is printing a regular (foreground) layer, it checks through the deck, 
starting from the first layer (layer 1 of ??), and if it finds any layers that have Background mode it prints 
them first, onto the same label or preview.

Lets suppose we have a sequence of layers with the following contents:

#1) \windows\honey.bmp - (Background/Bitmap)

#2) HoneyBee Software Inc - (Background/WYSIWYG)

#3) John Doe - (Shrink2fit)

#4) Steve Teale  - (Shrink2fit)

The "John Doe" layer is at the top of the deck, and we click it onto the layout.      LazaLabl zips 
through the deck, starting at #1.    It finds that layer #1 is in Background mode, so it displays it on the 
layout where we clicked.    It also finds that layer #2 is Background, so it displays that at the chosen point 
on the layout also.    The "John Doe" layer is #3,    that's the layer at the top of the deck, so it gets 
displayed at the chosen point also.    The search through the deck continues, but no more background 
layers are found.

If we clicked layer #4 onto the layout we would similarly get the two background layers combined with 
layer #4.

The same sort of sequence happens when LazaLabl is previewing or printing.

Note that background layers can have another mode as well.    The Background mode describes the 
circumstances under which they are to be printed.

If the label at the top of the deck is in background mode, selecting the Background option from the 
Options menu again turns background mode off.



Serialized
The Serialized mode for a label causes the text of the label to be taken as the starting number of a 
sequence.    Select it by choosing the Serialized option from the Options menu.

When labels of this sort are printed the serial number is incremented for each label printed.    Note, 
printed!    The incrementing doesn't happen when the labels are clicked onto the layout or previewed.

To simplify the setting up of serialized labels they are automatically set to be background labels.    You can
switch this off if you like.

To start a new sequence, simply edit the number on the layer in the deck.    The next sequence will start at
the number you have entered.    If you want the numbers to be changed by more than one each time they 
are printed, you can add a comma and another number.    If the label text is:

1234,3

then the next labels printed will have serial numbers 1234, 1237, 1240, 1243, etc.    Each serial number is 
increased by 3 from the previous value.

If you want the number padded with leading zeroes to a fixed number of digits, add another number to 
specify how many digits you want.    For example:

1234,3,6

will produce the sequence 001234, 001237,    001240, 001243, etc.

If you want some text tagged onto the front of the serial number, just add it.    For example:

ASDF1234,1,6

will produce ASDF001234, ASDF001235, ASDF001236, etc.    If the text you want to add in front contains 
digits, put the text in quotes, so:

"A01B"1234

will produce A01B1234, A01B1235, A01B1236, etc.

Serial number layers can can be in any of the text modes (Shrink2fit, Maximize, Scaled Text, WYSIWYG, 
with rotation or justification).      There is no particular limitation on the number of different    serial numbers 
that can be printed in the background, but you will need to use a separate layer for each one.

When you print labels of this sort, you modify a label!    When you quit or open another file, 
LazaLabl will ask if you want to save the changes.    If you don't, then the next batch printed will 
simply start at the original number.



Postal Bar Code

LazaLabl can print postal bar codes on labels, envelopes, reply cards etc.    The option is The Postal 
Bar Codes option of the Options menu, and it sets a mode for the layer.

In order for LazaLabl to do this the text of the card/label being printed should have as its last element
a ZIP code of the required number of digits.    ZIP codes can be 5 digit, 9 digit (ZIP+4), or 11 digit (Delivery
Point - ZIP+4+2).    In the 11 digit case,    the bar code must encode the last two digits, but the address 
should not show them, since this upsets the USPS character recognition software.    LazaLabl does 
not print these last two digits as part of the address when it is printing a postal bar code.    However if you 
want delivery point bar codes you must include these digits in the label text, or in your database, if that is 
where the text comes from.    If you're not printing bar codes, don't include these digits in the text.

LazaLabl will only print a postal barcode if it finds as the last item of the text, a 5, 9, or 11 digit 
number.    Spaces and newlines after the ZIP code are tolerated, and hyphens and spaces between the 
digits are ignored for the purpose of generating the bar code.    Typical acceptable forms are:

Normal ZIP code
07840

ZIP + 4
07840-4902

Delivery Point Code (ZIP + 4 + two last two digits of street number)
07840-4902 30

LazaLabl does no scaling when it prints postal bar codes.    They are printed in a size and position as 
per the preferred options presented in USPS Publication 25 - Designing Business Letter Mail.    The actual
address will normally be printed in Shrink2fit mode as usual.

A feature which surprises many users is that when bar codes are printed on labels, they are printed 
ABOVE the address.    According to the USPS publication, this is the preferred position.

The suggested label size for ZIP + 4 and Delivery Point bar codes is 4" x 1".    Regular 5 digit ZIP codes 
will fit on a standard 3-across (2.675" x 1") label.

If there are no margins set (i.e. zero margins), LazaLabl treats any object bigger than 5" wide by 3" 
high as a reply card or envelope, and prints the bar code in the lower right.    The target position is 0.25" 
from the bottom of the card/envelope and with the first bar 4.125" from the right hand side (as close as 
3.5" is acceptable but not desirable).

If LazaLabl is not achieving this position correctly it is probably because it is attempting to correct for 
wider than normal non-printing margin areas imposed by your printer.    You can correct this for your most 
frequently used card/envelope size by making a one-off alteration to the initialization file - LAZLAB.INI, 
that the installation program will have placed in your Windows directory.    In the [defaults] section you will 
find two entries called bcb and bcr

[defaults]
deffontface=Arial
height=-13
defcolor=0
mfr=userdef



stockid=05
lefttrim=0
toptrim=0
; these two entries
bcb=0
bcr=125

To move the bar code towards the bottom of the card/envelope, increase the bcb value.    An increase of 
125 is an eigth of an inch.    To move it up make the bcb value less.    It can be negative if necessary.    

To move the bar code to the right increase the bcr value, and to move it to the left decrease the bcr 
value.

As shipped you will find that bcr has a value of 125 which should be OK for envelope sizes specified 
without margins.

If margins are set, the postal bar code will be positioned at the top of the indicated area, and the text will 
be restricted to an area below it.    If the area defined by the margins isn't wide enough, LazaLabl will 
refuse to print the bar code with an audible warning.



Rectangle

LazaLabl can create filled or outline rectangles with a specified line thickness and color, and 
specified fill color.    Rectangle is a mode of the layer.    It is selected by choosing the Rectangle option 
from the Options menu.    Like bitmapped graphic elements, rectangles should be combined with text 
using Background mode or Superimpose.

As usual the text of the label, taken in combination with the margin settings etc, defines what is to be 
printed.    For a rectangle, the text may be blank, or can be just a single number, or a more complex 
specification.    The currently set margins define the size and position of the rectangle.

It's a good idea to "make" the rectangle by first entering the text that describes what you want (below), 
then dragging the margins with the mouse pointer on the preview to set an approximate size, shape and 
position.    Fine tune the rectangle by adjusting with the Margins Tool.

Simple rectangles

Set the thickness of the line by entering a number in the first line.    If Graphics Scaled to Margins is 
selected,    the thickness number is interpreted as relative to the size of the surrounding rectangle.    If you 
enter a number N,    the thickness used will be:

(average of rectangle side x    N)/1000;

This normalization is used so that all the geometric figures scale similarly.

If Graphics Scaled to Margins isn't set,    the number will be taken to request a line thickness in 1/1000ths 
of an inch.

Zero thickness will give a line thickness of exactly one pixel.

If there is no text, the rectangle is flood filled with whatever color you have selected for the label text.    
Note: If you simple select rectangle for a blank layer, the Preview will turn black - a black filled rectangle 
with no margins set.

If the text is a number is greater than zero it is taken as being the line thickness required (actually in 
printer pixels).    A corresponding thickness is approximated in the screen preview, though it won't ever 
look as thin as a one pixel line on the printer.    A frame of the specified thickness is drawn, using whatever
text color you select for the layer as a whole (not highlighted text).    This produces a rectangular outline - 
no filling is done.

Advanced rectangle design

If you want the outline of the rectangle to be a different color than the filling, specify a line thickness, and 
force filling by adding a letter 'f' as the first character of the layer.    You can make if "fill" if you like.    Then 
select the 'f', or the word "fill", and change the color of the selected text to the color you want for the fill, 
for example

fill 20

will make a rectangle sized by the set margins with a 20 unit black outline and red filling.    Units are in 
terms of the width of the rectangle defined by the current margin settings.    The width is taken to be 1000 
units.    The minimum    width is 1 pixel.

If you want a rectangle with rounded corners, add a letter 'r' or the word "round", and follow this by a 
number which is the required corner radius in thousandths of an inch.    For example:



round 500 20

will produce a rectangle with 1/2" radius corners and a 20 printer pixel line thickness.

round 500

will produce a black filled rectangle with similarly rounded corners.

The fill and round keywords can be combined to produce a rounded rectangle with a fill color different 
from it's outline, e.g.

fill round 500 20

Red filled rectangle with 1/2" radius corners and a 20 pixel black outline.



Superimpose
The Superimpose option is used to create composite labels comprising graphic elements and/or text of 
different sizes, fonts, and styles.    If you intend to include graphic elements in your cards/labels, you will 
need to use Superimpose or Background mode - graphics and text can't be mixed on the same card/label
in the deck.

As an example if there were two labels on the deck with the following texts:

Printing a label using the Superimpose option would produce a label with appearance 
similar to:

Superimpose is not a label mode, it is rather an attribute of the entire deck, which in this case represents
separate components of a single composition.    Each layer component is printed in sequence, starting 
from label 1 of n and progressing in strict order.

The order is important.    It determines which items are printed over others.    For example, text can be 
printed over a graphic element.    If you have got the order wrong you can correct it by deleting a layer, 
then clicking through the deck until you reach the layer that the deleted component should cover, then 
choosing Undelete from the Control menu.

All layer modes can be superimposed.

When LazaLabl stores labels in a file the mode information is stored with the label text and font 
information.    So if you first create a set of labels in Superimpose mode, then recover them from a file 
and print them again, they will be printed in Superimpose mode without any special action on your part.



Scaled Text
TrueType fonts are scaleable.    They can be displayed and printed at any required size, both vertically 
and horizontally.

Particular fonts are designed for a specific aspect ratio, that is the ratio of its character heights to its 
character widths.    Font designers go to some lengths to make their designs aesthetically pleasing at the 
designed aspect ratio.

However, some fonts look quite good when stretched horizontally or vertically, or you might prefer the 
"special effects" of stretching them, so LazaLabl allows you to do this.

The Scaled Text option allows you to specify an area, and have the text of a label scaled to fit within it, so
you can stretch or deform a font as you please.    The area for the scaled text is defined using the margins
tool.    To make the text of the card at the top of the deck scaled, select Scaled Text from the Options 
menu.    Type the required text into the label at the top of the deck, then set the right and bottom margins 
to indicate the area that you want the text to fill.    You can then use the left and top margins to move the 
text to the required position, or drag it there with the mouse pointer on the Preview.



Justification
Text is left justified by default, in the way you would expect for an address.    However if you are making 
business cards or invitation cards, it's not unusual to want the text to be centered.    Some applications 
may also require right justification.

Selecting the Justification option from the Options menu causes a sub-menu to appear.    Select Left, 
Centered, or Right as required.



Line
The Line option allows you to draw lines on your cards or labels.    The option supports horizontal and 
vertical, and uphill and downhill lines.    The default is horizontal.    Lines are defined by the currently set 
margins.

To make the layer at the top of the deck represent a line, select    Line from the Options menu.    Use 
Background or Superimpose mode to combine lines with other graphical or text components. Line is a 
mode of a layer - one layer defines one line.

A horizontal line will run along the top margin position, from left margin to right margin.    Put a letter 'h' or
'H', or no letter at all as the first character on the layer to get a horizontal line.

A vertical line will run along the left margin position, from the top margin to the bottom margin.    Put a 
letter 'v' or 'V' on the layer to get a vertical line.

A downhill line runs from the corner formed by the left and top margins to the corner formed by the right 
and bottom margins.    Put a 'd' or 'D' on the label/card to get a downhill line.

An uphill line runs from the corner formed by the left and bottom margins, to the corner formed by the top
and right margins.    Put a 'u' or 'U' on the label to get an uphill line.

Set the thickness of the line by adding to the line-type letter a number that specifies the line thickness.    If 
Graphics Scaled to Margins is selected,    the thickness number is interpreted as relative to the size of the 
surrounding rectangle.    If you enter a number N,    the thickness used will be:

(average of rectangle side x    N)/1000;

This normalization is used so that all the geometric figures scale similarly.

If Graphics Scaled to Margins isn't set,    the number will be taken to request a line thickness in 1/1000ths 
of an inch.

A zero thickness, or no number at all, are both taken to require a line thickness of exactly one pixel.    Set 
the color of the line using the palette, or if you are not using the palette, select a color via the font dialog 
box.

Examples:

No text on label - horizontal line, 1 printer pixel thick
4 - horizontal line, 4 printer pixels thick
h4 - horizontal line, 4 printer pixels thick
v12 - vertical line, 12 printer pixels thick
d - downhill line, 1 printer pixel thick
d4 - downhill line, 4 printer pixels thick
u12 - uphill line, 12 printer pixels thick

It's a good idea to "make" the line in the following steps.    Enter an orientation letter (h, v, d, or u) and a 
line thickness value.    Then drag the right and bottom margins with the mouse pointer on the preview to 
set an approximate line length and angle.    Fine tune it by adjusting with the Margins Tool.



Ellipse
The Ellipse option allows you to draw circles or ellipses on your cards and labels.    Ellipses are defined 
by the current margin positions.

To make the layer at the top of the deck represent an ellipse, select Ellipse from the Options menu.    
Use Background or Superimpose mode to combine ellipses with other graphical or text components.    
Ellipse is a mode of a layer - one layer defines one ellipse.

The ellipse will be drawn so that its outline lies on the set margins.    If the margins are set to make a 
square, the "ellipse" will actually be a circle.

It's a good idea to "make" the ellipse by entering the text that describes what you want (below), then 
dragging the right and bottom margins with the mouse pointer on the preview to set an approximate size 
and shape, the dragging the ellipse to the required position.    Fine tune it by adjusting with the Margins 
Tool.

Set the thickness of the line by entering a number in the first line.    If Graphics Scaled to Margins is 
selected,    the thickness number is interpreted as relative to the size of the surrounding rectangle.    If you 
enter a number N,    the thickness used will be:

(average of rectangle side x    N)/1000;

This normalization is used so that all the geometric figures scale similarly.

If Graphics Scaled to Margins isn't set,    the number will be taken to request a line thickness in 1/1000ths 
of an inch.

Zero thickness will give a line thickness of exactly one pixel.

No text on the label at all, will be interpreted as a request for a filled ellipse.    The ellipse will be filled with 
the color you select from the palette for that layer.

If you want the outline of the ellipse to be a different color than the filling, specify a line thickness, and 
force filling by adding a letter 'f' as the first character of the layer.    You can make if "fill" if you like.    Then 
select the 'f', or the word "fill", and change the color of the selected text to the color you want for the fill, 
for example

fill 20

will make an ellipse sized by the set margins with a 20 unit black outline and red filling.    Units are in 
terms of the width of the rectangle defined by the current margin settings.    The width is taken to be 1000 
units.    The minimum    width is 1 pixel.

You can also make variations on the ellipse theme - Arc, Chord, and Pie.

Typical specifications for an Arc would be:

arc 0 2700 10

This would make an arc starting at angle 0 degrees (three oclock if you like), and ending at angle 270 
degrees (6 oclock) - going counterclockwise, of line thickness 10 units.    The result would look something 
like:



A Chord is done as follows:

fill chord 900 2700 1

A pie as follows:

fill pie 300 900 1

The fill color and line thickness can be specified as per a regular ellipse.    Arcs are not filled, so specifying
a fill color for an arc does nothing.



Polyline

The Polyline item from the Options menu allows you to draw closed polygons, open polylines, or sets of 
unconnected lines.    The syntax for layers of this kind is more complex than for the other graphics 
primitives, since the shape of these figures is not determined by the set margins.    However they are 
useful for designing the sort of simple shapes commonly used in logos etc.

Polylines are defined by a set of coordinates, and LazaLabl currently deals with only 128 points.    
Negative coordinates are allowed.    The color of the polyline is the text color selected for that layer.    
Closed figures - polygons - can have a specified fill color.

If the Scale Graphics to Margins option of the Adjustments menu is selected for the layer which 
defines the Polyline, measurements are interpreted as relative to the rectangle defined by the set 
margins.    The width defined by the margins is defined to be 1000 units, and the height 1000 units.    It 
follows that in this mode, these figures are scaled to the set margins.    They can be grouped with lines, 
rectangles and ellipses, and will scale correspondingly.

If Scale to Margins isn't selected, the measurements are taken to be 1/1000ths of an inch.

Set the thickness of the line by entering on the first line a number that specifies the line thickness.    If 
Graphics Scaled to Margins is selected,    the thickness number is interpreted as relative to the size of the 
surrounding rectangle.    If you enter a number N,    the thickness used will be:

(average of rectangle side x    N)/1000;

This normalization is used so that all the geometric figures scale similarly.

If Graphics Scaled to Margins isn't set,    the number will be taken to request a line thickness in 1/1000ths 
of an inch.

A polygon is defined as per the following definition of a triangle, the comments (// comment) are not part 
of the definition.

20 // line thickness
100,100 // first point
100,1000 // second point
1000,100 // third point

In the polygon case,    LazaLabl will draw as many lines as there are points.    The last line will 
connect the last point back to the first point.    The numbers must be separated by some character other 
than digits or the minus sign, but it does not matter what separator you use.

To draw a filled polygon use

fill 20
100,100
100,1000
1000,100

The keyword "fill" makes the definition clear, but    'f' is sufficient.    Selecting "fill", or more specifically the 
first character of the text, and giving that its own color, as in the example, controls the fill color.

A polyline is defined as per the following definition of a letter 'W'.    The comments are not part of the 
definition.



open 20 // "open" keyword for polyline, and line thickness
100,100 // points
600,1000
1100,100
1600,1000
2100,100

In the polyline case there will be one less line than there are points, and the resulting figure is not closed.  
The "open" keyword makes the definition clearer, but 'o' is sufficient.    The fill keyword has no effect in this
case.

A set of separate lines is defined as per the following definition of lines to make a number eleven.

separate 20 // "separate" keyword, and line thickness
100,100
100,1000
600,100
600,1000

In the separate lines case there are half as many lines as there are points.    Each pair of points defines a 
line.    If there is an odd number of points,    the last one is ignored.    The "separate" keyword makes the 
definition clearer, but 's' is sufficient.    The fill keyword has no effect in this case.

If the Scale Graphics to Margins option of the Adjustments menu is selected, these figures are scaled 
to the set margins.



Character Outline

LazaLabl can convert the TrueType font information for a character into a set of polyline curves or 
polygons.    The Character Outline option of the Graphical Object section of the Options menu allows 
you to make outline characters from any TrueType font.    You can choose the thickness and color of the 
outline,    and you can fill the character with a color if you like.

As for the other graphical objects,    the details are controlled by the text you enter.    In this case the text 
can be as follows:

fill 50 A

To choose a fill color,    highlight the word fill, then click a color in the the Palette.    The number controls 
the outline thickness, use a number in the range 0 - 100.    If you use 0, or if there is no number, the 
outline thickness will be 1 pixel.    The final letter is the character to be outlined - just change the font for 
the label to the TrueType font you want to use.

fill A
50 A
A

are also acceptable.

By default, the character will have its TrueType aspect ratio preserved.    The size of the character will be 
controlled only by its height, as set by the top and bottom margin settings.    If you select Scale Graphics 
to Margins from the Adjustments Menu,    the characters will be stretched or squashed horizontally such 
that the widest character in that font will fit the set margins.



Time Stamp

LazaLabl can put the date, or the time, or both on a card or label.    A time or date is represented by a
single layer - Time Stamp is a mode.    Combine a time/date layer with other components by using 
Background mode for the time/date label, or use Superimpose.

Select the Time Stamp option from the Options menu.    If there is no text on the layer, that layer will now
represent a date.    Put a 't' on the label for a time, or 'f' (f for full) for an extended time/date format.    You 
can also put 'd' for a date.    If you want the time to be on a 24 hour clock, put "t24" on the label.

Time stamps can be in any of the text modes -    Shrink2fit, Maximize, Scaled Text, or WYSIWYG.

A time stamp - 't' - looks like:

10:04am
01:25pm

or - "t24":

10:04
13:25

A date - 'd' or no text on the label - looks like:

03/03/94

A full date - 'f' - looks like:

Thu Mar 3 10:17:10 1994



Non-Printing Template

In some situations it is useful to design a Deck which has one or more layers that show on the preview 
and the layout, but which don't get printed.

A typical example would be in the production of tri-fold flyers on pre-printed stock with a decorative 
background.

In a case like this the non-printing layer can show a picture, or more probably,    an outline of the 
background pattern.    This will aid in the design of a composition, since it will then be easy to ensure that 
the contents are properly positioned with respect to the background.    However in that case we would not 
want the outline to be printed.

Other examples would be the outline of a rotary card, or the hole in the middle of an audio tape casette 
label.

Non-Printing Template is an on/off mode of a layer.



Program Layer

Layers containing a Programs allow a number of objects of different types to be contained in a single 
layer,    and to be constructed by a merge.

The Program option of the Options menu allows the Program attribute for a layer to be turned on and off.



End of Group
Any layer except a group layer may be marked as a Group End.    The End of Group option of the 
Options menu allows such markings to be set or cleared.

Group end markings allow control over the construction of Groups.



Bar Code

If you have the optional bar-code module, LazaLabl can render the popular bar-code formats:

Code 39
EAN/UPC
Code 128
Interleaved 2 of 5
Codabar

The rendering of bar codes is controlled by the Bar Code Preferences dialog box of the Adjustments 
menu.    This dialog box allows you to control the following features of the bar code.

Symbology (i.e. which type of bar code)
Human readable text (Yes/no)
Human readable text inset (how far is the text inset into the bar code - 100% is fully inset)
Surrounding box
Check character (in some symbologies    a check character is optional)

The example is Code 39,    it has human readable text inset 75%, a surrounding box, and no check 
character:

The bar code rendered corresponds to the text of the layer for which the Bar Code option is selected.    If 
the symbology does not support any of the characters in the text, the bar code will not be rendered.

The size of the rendered bar code is controlled by the margin settings.    If a bar code corresponding to the
text can not be rendered within the recommended tolerances in the area specified, LazaLabl draws 
an approximation, then defaces it by drawing a bold X across it.    This will often happen when bar-code 
renderings are placed on the Layout.    Screen resolution is not adequate for many small bar code 
renderings.    If the Preview looks OK the bar code is almost certain to print correctly,    but in designing 
bar code labels you shouls always print some tests and test then by scanning the bar codes.





Groups

LazaLabl allows a number of layers in the deck to be combined together to make a group.    You can
also be break up a group to change it back to a set of regular layers.    Why might you want to do this?

Well, suppose you wanted to make a tri-fold flyer (a letter size sheet folded in three).    Each of the three 
panels on one side of the sheet is to be composed of a number of superimposed layers, so that you can 
combine graphics and text with complete flexibility.    Then you'd want to be able to fill the layout with the 
set of three panel designs, and print them out.    In the normal way of working you can't do this.    Each 
design, if using superimposition, accounts for the entire deck.    If you fill a three panel sheet from such a 
design you will simply get the same design repeated three times.

To get around this limitation, somehow each of the designs has to be squashed into a single layer.    Then 
we can make a deck of three layers, one representing each design, so that when we fill the sheet, each 
design fills a panel of the Layout.

Groups allow you to do this sort of job efficiently.    The first design is done as a set of background layers, 
then made into a group - a group is a single layer.    Then the second design is done as another set of 
background layers and made into a second group, and so on for the third.    Then you can just fill the 
layout.    If you want to alter one of the panel designs, just break up that group layer, modify as required, 
then group it again.



Make Group
The effect of the Make Group option is to collect layers starting from the one at the top of the deck, and 
proceeding until either the last layer (label n of n) is reached, or until a layer is found which was marked 
with the Group End option.    All these collected layers are then combined to make a single group layer.    
Groups can be nested, that is a group can contain layers which are themselves groups

Printing a group layer is equivalent to printing a superimposed combination of all the collected layers, with
each one scaled to the margins defined for the group layer.    The group layer itself can be regarded as a 
non-printing layer.    When a group is created,    LazaLabl sets the text of the layer to something like:

6 layer group

You can edit this text to make it a description of what the group contains if you like.    Don't bother to do 
this until you are through with un-grouping and making modifications, because you'll lose your annotation 
every time you un-group.



Break up Group
The Break up Group option has the opposite effect than the Make Group option.    The collected layers 
which were hidden behind the group layer are slipped back into the deck, in their original order.    The 
layer that represented the group is lost.    The last of the restored layers is marked with the End Group 
option so you can easily group them again.    After the ungroup, the last of the restored layers will be at 
the top of the deck.

Setting a Group End

The Make Group operation collects layers into the group until the last layer in the deck is reached, or until 
a layer is reached which is marked as a Group End.    The last layer in a group is marked as a Group End
automatically when a group is broken up,    and in many cases when groups are made in sequence this 
method of setting group ends may be all that is required.    On other occasions it will be appropriate to 
explicitly set a Group End.    Set the Group End property by using the End of Group option of the Options
menu.    The same option may be used to turn this property off again.



Program
A program layer lets you make a complex composition on a single layer.    Program layers are provided so
that you can make such compositions on the fly by merging.    Typical applications are ID cards and 
product labels.

In the case of an ID card, for example, it will be required that each card on a sheet has different text.    
This could be dealt with by a regular text merge using a single text template layer.    However, on the ID 
cards you will probably also want to have a picture of the individual and maybe a bar code, and this is 
where you will need a program layer.

Suppose you have database (delimited text) records with the following fields

1 ID number
2 First Name
3 Last Name
4 Department
5 Room #
6 File name for ID picture

A program layer for making sets of ID cards could look as follows:

.cou 125,0,1000,1000,<Arial,14,b>[1]

.cg 2250,250,1000,1000,[6]

.cb 250,1125,2000,500,[1]

.250,250 Acme Ventures
Dept: [4]
Room # [5]
.2250,1125 [2]
[3]

The lines at the start of this program, starting with ".c" would normally be taken by LazaLabl (in 
WYSIWYG mode) to be comment lines.    That is they would simply be ignored.    You can use comment 
lines in merge specifications to note what the template is for etc.    However if the layer is a program layer, 
LazaLabl treats certain comments as program instructions.    If you always want a line to be treated as 
a comment, add a spce after the ".c".

Let's break this program down into its components.    The first line, with an "o" after the ".c" defines an 
oriented text item.    This one has the 'u' orientation - it's to be written up the left hand side of the rectangle
defined by the numbers that follow - left, top, width and height.    The angle braces that follow define the 
required font - Arial 14 point bold.    The text for the oriented text is to be taken from field 1 - the ID 
number.

The next line, which has "g" for graphic after the ".c", defines the picture we want on the card.    The input 
data needs to contain a .BMP or .WMF file name.    This is to be positioned at 2250,250 (2.25" form the 
left, and 0.25" from the top), in a box 1inch square.    The file name will be taken from field 6.

The next - .b - line defines the bar code.    It is to be positioned at 0.25 inches from the left and 1.33 
inches from the top in an area 2 inches wide and half an inch high.    The text is the ID number again, 
taken from field 1.

The next line is not a comment line, so we are now finished with program instructions.    The rest of the 
layer is interpreted as WYSIWYG text, just a regular merge.



When the layer has been interpreted (merged) from a record it will look something like the following:

.cou 125,0,1000,1000,<Arial,14,b>2115

.cg 2250,250,1000,1000,DOE.BMP

.cb 250,1333,2000,500,2115

.375,1125 Acme Ventures
Dept: Engineering
Room # 201
.2250,1333 Jane
Doe
When the program layer is printed, this program will produce:

This uses only one layer, so the merge can make a different ID card on each panel in the layout, each 
with its own text, ID number, bar code and picture.

The program instruction types you can use are:

.cs Shrink to fit text

.cm Maximized text

.ca scAled text

.co Oriented text

.cg Picture - .BMP or .WMF file name required

.cp Postal bar code, a valid ZIP code required

.cc Color code - a colored rectangular block

Note that programs don't support serial numbers.    If you want a plain incrementing serial number, do it as
a background layer.    Quite possibly though you will want to generate your ID numbers etc. as part of the 
merge data, as in the example above.

Remember also that you can use backgrounds to lay down elements of the composition that don't change
from label to label (card to card).    The program elements are intended for the representation of those 
elements that will change from label to label.

The syntax for the program instructions is presented below.    xpos, ypos, width and height are in 1/1000 
of an inch.    Optional elements are enclosed in square braces ([ and ]).    The '|' character is used to 
indicate OR.



Shrink to Fit
.cs[l | c | r] xpos,ypos,width,height[<Font Name,points,style[,red,green,blue]>]
.c+This is the text
.c+that will be shrunk
.c+to fit

The text for the shrink-to-fit element is contained in ".c+" comment - lines following the ".cs" program line.  
The optional 'l', 'c', or 'r' control justification, left, right or centered.    The 'p' option specifies that a postal 
bar code is to be generated if appropriate ZIP information is found at the end of the text.    Font style is 
indicated by 'n', 'b', 'i', or "bi", for normal, bold, italic, or bold italic.    Red, Green, and Blue are numbers in 
the range 1 through 125 indicating the color mix required.    If you want to use one of LazaLabl's 
palette colors, click on the required color (on the palette), with the SHIFT key held down.    LazaLabl 
will put the required text into the clipboard so you can paste it into your program.



Maximize
.cm[l | c | r] xpos,ypos,width,height[<Font Name,points,style[,red,green,blue]>]
.c+This is the text
.c+that will be maximized

The text for the maximized element is contained in ".c+" comment - lines following the ".cm" program line. 
The optional 'l', 'c', or 'r' control justification, left, right or centered.    The 'p' option specifies that a postal 
bar code is to be generated if appropriate ZIP information is found at the end of the text.    Style is 
indicated by 'n', 'b', 'i', or "bi", for normal, bold, italic, or bold italic.    Red, Green, and Blue are numbers in 
the range 1 through 125 indicating the color mix required.    If you want to use one of LazaLabl's 
palette colors, click on the required color (on the palette), with the SHIFT key held down.    LazaLabl 
will put the required text into the clipboard so you can paste it into your program.



Scaled Text
.cc[l | c | r | p] xpos,ypos,width,height[<Font Name,points,style[,red,green,blue]>]
.c+This is the text
.c+that will be scaled

The text for the scaled text element is contained in ".c+" comment - lines following the ".cc" program line.   
The optional 'l', 'c', or 'r' control justification, left, right or centered. The 'p' option specifies that a postal bar
code is to be generated if appropriate ZIP information is found at the end of the text.    Style is indicated by
'n', 'b', 'i', or "bi", for normal, bold, italic, or bold italic. Red, Green, and Blue are numbers in the range 1 
through 125 indicating the color mix required.    If you want to use one of LazaLabl's palette colors, 
click on the required color (on the palette), with the SHIFT key held down.    LazaLabl will put the 
required text into the clipboard so you can paste it into your program.



Oriented Text
.co[u | d | i] xpos,ypos,width,height[<Font name,points,style[,red,green,blue]>]Text

The text for the oriented text element goes at the end of the program line - multi-line roteted text isn't 
supported in program layers.    The optional 'u', 'd', oe 'i' control orientation, up, down, or inverted.    If none
are specified, normally oriented WYSIWYG text is assumed.    Style is indicated by 'n', 'b', 'i', or "bi", for 
normal, bold, italic, or bold italic.    Red, Green, and Blue are numbers in the range 1 through 125 
indicating the color mix required.    If you want to use one of LazaLabl's palette colors, click on the 
required color (on the palette), with the SHIFT key held down.    LazaLabl will put the required text 
into the clipboard so you can paste it into your program.



Picture
.cg xpos,ypos,width,height,Picture file name

The picture element is scaled to fit in the specified rectangle.    If the picture file name does not include a 
path, LazaLabl searches first in the LazaLabl home directory, then in the Windows directory.    If 
the file is not found, the attempt to display the program is terminated.



Postnet bar code
.cp xpos,ypos,width,height,ZIP code

The postal bar code is drawn starting at the position specified.    Width and height are ignored.    The code 
will be drawn if the ZIP code has an appropriate number of digits, and if it will fit between the specified 
starting point and the right side of the card/label.    Users are referred to Post Office publication 25 for 
guidance on mail piece design.



Color coding
.cc xpos,ypos,width,height,red,green,blue

Red, Green, and Blue are numbers in the range 1 through 125 indicating the color mix required.    If you 
want to use one of LazaLabl's palette colors, click on the required color (on the palette), with the 
SHIFT key held down.    LazaLabl will put the required text into the clipboard so you can paste it into 
your program.





Help Menu

LazaLabl incorporates context sensitive help for each of its menu options.

To get help on any particular menu item, use the cursor control keys to move the highlight bar to the 
required item, then press function key F1.

Selecting the Help option from the Help menu will cause the help system to display an index of help 
topics.    To get help on one of these topics click with the mouse on the topic title.



Help Index
Selecting the Help option from the Help menu, or clicking the    icon on the toolbar will cause the help 
system to display an index of help topics.    To get help on one of these topics click with the mouse on the 
topic title.



About
Choosing the About LazaLabl option causes display of a message box containing version number 
information for the LazaLabl product.

You should make a note of the version number if you need to report any operating problem to SoftCentre.



Sizing and Moving Objects Using the Mouse
You can set the margins for the label at the top of the deck using the Margins Tool, and you can shuffle 
through the deck by clicking close to it with the left or right mouse buttons, or using keys F7 and F8, or by 
using the GoTo Label# option from the toolbar or the Edit menu.

You can do similar things using the mouse to operate directly on the Preview Panel.    The margins for the
card/label at the top of the deck are shown on the preview as an "elastic rectangle", a thin-dotted-line 
rectangular box.    You can move or, in some cases, size the object on the card/label at the top of the deck
by manipulating this dotted rectangle.    To move it, place the mouse cursor in the middle of the box 
(approximately), hold down the left mouse button, and drag the rectangle to where you want the object to 
be.

When you release the left mouse button the object will move to the new position.    To stretch the 
rectangle you can place the mouse cursor on the dotted line, or just inside it.    If you hold down the left 
mouse button and move the mouse pointer you will then move that side of the elastic rectangle, or if you 
have grabbed it by a corner, the adjacent two sides. The shape of the mouse cursor will change to show 
which part of the object you have grabbed.    There are shapes for the whole object - shown above, the 
sides, and the corners.    The side and corner shapes are the ones which normally appear to resize a 
window.

To switch to another object, that is to bring another card/label to the top of the deck, first just try clicking 
on the object in the preview.    If the elastic rectangle doesn't switch to the object you want,    it's probably 
because the object you want is "underneath" the current elastic rectangle, so the mouse pointer can't 
"see" it.    In that case hold down the Shift key and click.      If the object you want is buried under several 
others you may have to hold down the Shift key and click on it a few times to select it.    Note that the 
card/label at the top of the deck changes to the one you selected, and that if the Margins Tool is showing 
it will reflect any margins changes you make using the mouse pointer.

If you want to look at the preview without the clutter of the elastic rectangle,    select the Hide Preview 
Sizing Box from the Adjustments menu, or hold down the Ctrl key and click the mouse left button.    
Repeating the Ctrl+left-click will turn it on again.

Using the mouse to move things around is good for initial positioning, but you may find the Margins Tool 
more convenient for exact alignment of different objects, or to achieve precise dimensions.



Keyboard Interface for Musophobes
If you hate mice,    or aren't able to use one,    you may find the following keyboard capabilities useful.

1)    Controlling the Margins Tool using the Keyboard

* Turn on the Margins Tool using the menu system - (Alt+C,    M).
* Use Ctrl+Shift+M to switch focus to the Margins Tool if it isn't active.
* Use Tab to switch between scroll bars.
* Use left, right, up, down, page up, and page down to move scroll bars.
* Press Esc to switch the focus back to the Deck.

2)    Selecting Colors using the Keyboard

* Turn on the Color Palette using the menu system (Alt+O,    C).
* Use Ctrl+Shift+P to switch focus to the Color Palette.
* Use left, right, up, down, page up, and page down to select colors.
* Press Esc to switch the focus back to the Deck.

3) Placing Items on the Layout using the Keyboard

* Turn on Place Items Using Keyboard    mode by pressing Ctrl+K.
* Position the dotted highlight rectangle using the left, right, up, and down keys.
* Place the item at the top of the deck by pressing the space bar.
* Shuffle through the deck using F7 (back) and F8 (forward).
* Press Esc to return to normal operations.

Other keystroke operations are sumarized below:

The function keys F1 through F10 are defined as shortcut keys for the following operations:

F1 Help on currently highlighted menu item
(Normal Windows action)

F2 Fill the layout from the Deck
Ctrl+F2 Clear the layout
F3 Start another label
F4 Clone (copy) a new label from the one at the top of the Deck
F5 Expose Layout
F6 Expose label Deck
F7 Flip to previous label in Deck
F8 Flip to next label in Deck
F9 Preview
F10 Highlights first top level menu (Normal Windows action)

Various letter keys combinations with the Ctrl key are also provided:

Ctrl+A Start another label (a new label at the top of the Deck).
Ctrl+C Clone a copy of the topmost label in the Deck
Ctrl+D Delete the topmost label in the Deck
Ctrl+F Font dialog box
Ctrl+G Go to specified label
Ctrl+K Switch on Place Items using Keyboard
Ctrl+N Flip to next label in the Deck
Ctrl+P Print immediate
Ctr+R Refresh the layout






